In this Apple-certified guide, author David Dvorin demonstrates the powerful advanced features in Logic Pro X that have led many of the world’s top producers, composers, and engineers to make this program the centerpiece of their music studios. Starting with tips to speed up your workflow, he teaches you how to fully utilize Logic’s deep feature set for music production and editing, notation, and working with video. Along the way, he reveals real-world techniques for mixing, editing, and producing, and shares professional secrets for streamlining production workflows and constructing a mix to meet the most exacting standards.

Experienced Logic users and newcomers alike will find invaluable methods for manipulating tempo and pitch, fine-tuning audio and MIDI tracks, managing signal flow, and programming Logic’s revolutionary software instruments.

- Downloadable lesson and media files allow you to perform the hands-on exercises.
- Focused lessons take you step by step through professional real-world projects.
- Accessible writing style puts an expert instructor at your side.
- Ample illustrations help you master techniques fast.
- Lesson goals and time estimates help you plan your time.
- Chapter review questions summarize what you’ve learned.
Acknowledgments
Love and humble thanks to my wife Keri, son Jonah, and daughter Zinnia for their support and patience throughout the writing of this book.

Special thanks to all of the talented musicians who provided material for use in this edition of the book:

Harrison “Polo” Hedriana and The Colonel’s Men for their song “Midnight Wonder”
Grant Levin for his composition “A Blues for Trane”
Rocky Winslow and Randy McKean for playing on “Georgie the Spider”
Steve Martin for the use of the “2nd Impressions” footage
Caesar Filori and Wideband Network for providing “Anatomy of a Human Bomb”
Contents at a Glance

Getting Started ................................................................. xi

Setup and Production
Lesson 1  Speeding Up Your Workflow ................................. 3
Lesson 2  Working with Time and Pitch ................................. 33

Creating Your Own Sounds with Software Instruments
Lesson 3  Synthesis with the ES2 Synthesizer ........................... 81
Lesson 4  Sampling with the EXS24 .................................... 117
Lesson 5  Sound Design with Sculpture ................................. 149
Lesson 6  Building Drum Sounds with Ultrabeat ..................... 165

Editing
Lesson 7  Working with the Arrangement ............................... 197
Lesson 8  Advanced Audio Editing ..................................... 235
Lesson 9  Advanced MIDI Editing ...................................... 279

Mixing
Lesson 10  Managing the Mix ............................................... 319
Lesson 11  Controlling Signal Flow ................................... 349
Lesson 12  Controlling the Mix ......................................... 379

Advanced Topics
Lesson 13  Working with Surround .................................... 419
Lesson 14  Real-time MIDI Processing ................................. 451
Lesson 15  Working with Notation .................................... 501
Lesson 16  Working with Picture ....................................... 559

Index .......................................................... 587

See last page of this eBook for instructions on downloading your lesson files.
# Table of Contents

Getting Started ............................................ xi

## Setup and Production

<table>
<thead>
<tr>
<th>Lesson 1</th>
<th>Speeding Up Your Workflow ..................... 3</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Creating Your Own Template ..................... 4</td>
</tr>
<tr>
<td></td>
<td>Customizing the Interface ....................... 8</td>
</tr>
<tr>
<td></td>
<td>Using Key Commands ................................ 16</td>
</tr>
<tr>
<td></td>
<td>Accessing the Tool Menu ............................ 22</td>
</tr>
<tr>
<td></td>
<td>Saving a Project Template ....................... 27</td>
</tr>
<tr>
<td></td>
<td>Opening and Creating Projects Automatically .... 27</td>
</tr>
<tr>
<td></td>
<td>Backing Up and Transporting Your Setup ........... 29</td>
</tr>
<tr>
<td></td>
<td>Lesson Review ..................................... 31</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Lesson 2</th>
<th>Working with Time and Pitch .................... 33</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Stretching and Compressing Time .................. 34</td>
</tr>
<tr>
<td></td>
<td>Using Flex Time .................................... 37</td>
</tr>
<tr>
<td></td>
<td>Using Flex Pitch ................................... 58</td>
</tr>
<tr>
<td></td>
<td>Working with Rubato Passages ..................... 67</td>
</tr>
<tr>
<td></td>
<td>Lesson Review ..................................... 76</td>
</tr>
</tbody>
</table>

## Creating Your Own Sounds with Software Instruments

<table>
<thead>
<tr>
<th>Lesson 3</th>
<th>Synthesis with the ES2 Synthesizer ............. 81</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Understanding the User Interface ................. 82</td>
</tr>
<tr>
<td></td>
<td>Exploring the Oscillator Waveforms ............... 83</td>
</tr>
</tbody>
</table>
Contents

Using Oscillator Modulation to Create Interesting Sounds . . . 88
Sculpting Your Sound Using the Filters......................... 92
Using Modulation............................................. 98
Exploring the Output/Processing Section..................... 113
Lesson Review.................................................. 115

Lesson 4
Sampling with the EXS24........................................ 117
Creating Sampler Instruments................................. 118
Using the EXS24 Instrument Editor.......................... 120
Creating Loop Points.......................................... 125
Using the Parameter Window.................................. 130
Creating Multiple Zones from Region Transients........... 132
Using Filters and Modulation to Process the Sound...... 136
Using Groups....................................................... 139
Routing Individual Sounds for Processing................. 143
Lesson Review.................................................. 147

Lesson 5
Sound Design with Sculpture................................. 149
Understanding the User Interface............................ 150
Understanding the String...................................... 151
Using Objects in Sculpture.................................. 153
Adjusting the Pickups........................................ 157
Processing the Sound........................................... 158
Using Modulation in Sculpture............................... 159
Saving and Trying Presets..................................... 162
Lesson Review.................................................. 163

Lesson 6
Building Drum Sounds with Ultrabeat....................... 165
Selecting Sounds in the Assignment Section................. 166
Exploring the Sound Generators.............................. 168
Processing with the Filter and Bitcrusher.................. 179
Creating Drum Patterns with Step Sequencing............. 181
Automating Parameters in Step Mode....................... 188
Lesson Review.................................................. 192
Editing

Lesson 7  Working with the Arrangement ............... 197
          Navigating the Arrangement ......................... 198
          Using Markers ........................................ 206
          Saving Arrangements as Alternative Files .......... 216
          Using Global Edits .................................... 218
          Comparing Arrangements .............................. 231
          Lesson Review ........................................ 232

Lesson 8  Advanced Audio Editing .................... 235
          Smoothing Transitions with Crossfades .............. 236
          Fixing Clicks in the Audio File Editor .............. 242
          Creating New Parts from Existing Ones .............. 245
          Editing with Mixer Groups ............................. 255
          Repairing Drums with Marquee Transient ........... 265
          Lesson Review ........................................ 277

Lesson 9  Advanced MIDI Editing ...................... 279
          Using Aliases ......................................... 280
          Working with Region Parameters ..................... 283
          Selecting MIDI Events for Editing ................... 300
          Using MIDI Transform Functions ..................... 302
          Separating MIDI Events ............................... 313
          Lesson Review ........................................ 315

Mixing

Lesson 10 Managing the Mix ............................. 319
          Importing Channel Strips and Data .................. 320
          Working with the Mixer ................................ 322
          Creating Production Notes ............................. 329
          Panning Stereo Tracks .................................. 331
          Switching the Contents of the Plug-in Window ..... 334
          Changing Plug-in Locations ............................ 337
          Using a Plug-in’s Extended Parameters ............. 338
Using Mixer Groups ........................................ 339
Lesson Review ........................................... 346

**Lesson 11**

Controlling Signal Flow ............................... 349
Using Side Chain Effects ............................... 350
Positioning Sends Pre or Post Channel Strip Controls 356
Labeling Your Audio Interface's Inputs and Outputs . 364
Incorporating External Effects Processors .............. 367
Bouncing in Place ....................................... 371
Lesson Review ........................................... 376

**Lesson 12**

Controlling the Mix ...................................... 379
Editing Automation ...................................... 380
Applying Automation to Multiple Tracks at Once ....... 390
Using Control Surfaces .................................. 398
Lesson Review ........................................... 415

**Advanced Topics**

**Lesson 13**

Working with Surround ............................... 419
Configuring Logic for Surround ...................... 420
Mixing in Surround ......... ............................. 423
Using Surround Effects ................................. 433
Checking the Surround Mix ........................... 441
Downmixing .............................................. 444
Bouncing the Surround Mix ............................ 446
Lesson Review ........................................... 448

**Lesson 14**

Real-time MIDI Processing ............................ 451
Processing MIDI with MIDI Plug-ins ................. 452
MIDI Processing in the Environment .................. 458
Navigating in the Environment ......................... 458
Creating Environment Objects ....................... 462
Creating Signal Chains ................................ 475
Using Touch Tracks Objects .......................... 489
Lesson Review ........................................... 498
<table>
<thead>
<tr>
<th>Lesson 15</th>
<th>Working with Notation ...................... 501</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Creating Notation ............................ 502</td>
</tr>
<tr>
<td></td>
<td>Entering Notes Using Graphic Input .......... 503</td>
</tr>
<tr>
<td></td>
<td>Entering Notes Using Step Input ............. 513</td>
</tr>
<tr>
<td></td>
<td>Working with Guitar Notation ................ 515</td>
</tr>
<tr>
<td></td>
<td>Working with Text ............................ 524</td>
</tr>
<tr>
<td></td>
<td>Creating Chord Charts ......................... 528</td>
</tr>
<tr>
<td></td>
<td>Transcribing a Performance .................... 536</td>
</tr>
<tr>
<td></td>
<td>Working with Drum Notation ................... 541</td>
</tr>
<tr>
<td></td>
<td>Creating Scores and Parts ..................... 547</td>
</tr>
<tr>
<td></td>
<td>Lesson Review .................................. 557</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Lesson 16</th>
<th>Working with Picture ........................ 559</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Creating Post-Production Audio ............... 560</td>
</tr>
<tr>
<td></td>
<td>Opening the Movie ................................ 563</td>
</tr>
<tr>
<td></td>
<td>Using Markers to Spot the Movie .............. 569</td>
</tr>
<tr>
<td></td>
<td>Importing Media ................................ 574</td>
</tr>
<tr>
<td></td>
<td>Positioning Events on the Timeline .......... 577</td>
</tr>
<tr>
<td></td>
<td>Creating the Score ................................ 579</td>
</tr>
<tr>
<td></td>
<td>Exporting Audio to Movie ..................... 582</td>
</tr>
<tr>
<td></td>
<td>Lesson Review .................................. 584</td>
</tr>
</tbody>
</table>

| Index     | ................................................. 587 |

See last page of this eBook for instructions on downloading your lesson files.
We are lucky to live during one of the most exciting periods in the history of the music production industry. Just a few years ago, you would need a studio filled with synthesizers, hardware effects processors, mixing consoles, and expensive multitrack tape machines to accomplish what you can now produce in a small project-based environment with a computer, an audio interface, and the right software. It’s a good time to be a musician.

*Apple Pro Training Series: Logic Pro X Advanced Audio Production: Composing and Producing Professional Audio* is intended to help experienced composers, arrangers, and producers enhance their current Logic skills while working with real projects based on real-world scenarios.

You’ll learn how to accelerate editing tasks and increase the overall efficiency of your production workflow. You’ll refine your mixing techniques, manipulate tempo and pitch, create notated parts and scores, mix for surround sound, and develop music and audio tracks for video and film. You’ll unlock the limitless potential of the groundbreaking software instruments in Logic by creating your own sounds from scratch.

Whether you’re tweaking a song structure, applying effects processing, or editing audio and MIDI tracks, this book explains insider techniques to make your time with Logic Pro X more productive and creative.
The Methodology

This book is written for users who already have a working knowledge of Logic Pro. (Beginning or less-experienced Logic users should read Apple Pro Training Series: Logic Pro X 10.1: Professional Music Production by David Nahmani (Peachpit Press). Composers, audio engineers, and music producers currently working with Logic Pro will have the most to gain from this book.

The book is divided into six sections:

▶ Lesson 1 lays a foundation by helping you customize your Logic workflow. You’ll create an environment designed to increase efficiency well after you’ve completed the exercises in the book.

▶ Lesson 2 reveals the deep Logic feature set for manipulating time and pitch, including Flex Time and the new Flex Pitch feature.

▶ In Lessons 3 through 6, you’ll create your own sounds using the most advanced software instruments in Logic: ES2, EXS24 mkII, Sculpture, and Ultrabeat. Gaining an understanding of these powerful synthesizers and samplers will add a wealth of musical resources to your future sessions.

▶ In Lessons 7 through 9, you’ll shape your tracks into an arrangement. Using the MIDI and audio editing tools, you will refine the sound and structure of your composition, correcting production problems and making the most of your best takes.

▶ A composition is only as good as it sounds, which makes mixing and mastering your arrangement an essential part of the creative process. Lessons 10 through 12 guide you in taking your composition to the final level. You’ll use the Logic Pro Mixer, automation, control surface support, and effects processing to bring your creative output to highest degree of production quality.

▶ For many projects, Logic Pro will be an all-inclusive working environment that carries composers and producers from musical idea to final recording, from manuscript paper to the big screen. Lesson 13 provides a foundation for developing your surround sound mixing skills by using Logic’s extensive surround support. In Lesson 14 you’ll creatively process MIDI data both with MIDI plug-ins and by creating objects in the Environment. Lesson 15 shows you how to use Logic Pro’s extensive notation capabilities to create musical parts and scores. Finally, in Lesson 16 you’ll explore Logic Pro’s power as a film and video scoring tool.
System Requirements

Before beginning to use Apple Pro Training Series: Logic Pro X Advanced Audio Production: Composing and Producing Professional Audio, you should have a working knowledge of your computer and its operating system. Make sure that you know how to use the mouse, navigate standard menus and commands, and also open, save, and close files. If you need to review these techniques, see the printed or online documentation included with your system.

For the basic system requirements for Logic Pro X, go to www.apple.com/logic-pro/specs.

Preparing Your Logic Workstation

The exercises in this book require that you install Logic Pro X along with its default media content. If you have not yet installed Logic, you may purchase it from the App Store. When your purchase is completed, Logic Pro X is automatically installed on your hard drive.

All the instructions and descriptions in this book assume that you installed Logic Pro X on a Mac without any legacy Logic media, and that you downloaded all the additional media except for the Legacy and Compatibility content.

When you first open Logic Pro X, the app will automatically download and install about 2 GB of essential content. An alert then offers to download additional media content.

Click Download Additional Content to install all the Logic Pro X media content. In the Additional Content window, click the Select All Uninstalled button at the lower left, and double-click the “Legacy and Compatibility” checkbox to deselect it. Depending on the speed of your Internet connection, the following download may take several hours.

NOTE: If you have already installed Logic Pro X but did not install the additional content, choose Logic Pro X > Download Additional Content, and click Select All Uninstalled (make sure the “Legacy and Compatibility” content is not selected). Finally, click Install.
After you’ve installed all additional media, your Additional Content window will resemble the following figure:

![Additional Content Window]

**NOTE** ▶ If you have previously installed the “Legacy and Compatibility” content, or if earlier versions of Logic are installed on your Mac, you may not always see the same results as those shown in this book, especially when viewing the library, the Loop Browser, or the plug-in settings menus.

**Downloading and Using the Logic Lesson Files**

The downloadable content for *Apple Pro Training Series: Logic Pro X Advanced Audio Production: Composing and Producing Professional Audio* includes the project and media
files you will use for each lesson. After you save the files to your hard disk, each lesson
instructs you in their use.

To download these files, you must have your access code, which is available on a card
placed in the back of the printed editions or on the “Where Are the Lesson Files?” page in
electronic editions. When you have your code, do the following:

1  Using a browser, go to www.peachpit.com/redeem, and enter your access code.

2  Click Redeem Code, and sign in or create a Peachpit.com account.

3  In the Lesson & Update Files tab, locate the downloadable files on your Account page.

4  Click the lesson file link and download the file to your Mac desktop.

   **NOTE** ▶ If you purchase or redeem a code for the electronic version of this book
directly from Peachpit, the lesson file link will automatically appear on the Lesson &
Update Files tab without the need to redeem an additional code.

5  After downloading the file to your Mac desktop, you’ll need to extract the .zip file to
your Mac desktop to access a folder titled Advanced Logic X_Files.

   The Advanced Logic X_Files folder contains two subfolders—Lessons and Media—
that contain the project files for this course. Make sure you keep these two folders
together in the Advanced Logic X_Files folder on your hard disk. When you do so,
your Mac will maintain the original links between the lessons and media files. Each
lesson explains which files to open for that lesson’s exercises.

**Using Default Preferences and Selecting the Advanced Tools**

All the instructions and descriptions in this book assume that you have enabled the
Advanced Tools in Preferences. If you haven't, follow these steps:

1  Choose Logic Pro X > Preferences > Advanced Tools.

2  Select Show Advanced Tools.

3  Click the Enable All button.
Using the U.S. Key Command Preset

This book assumes that you are using the default initialized key command preset for a U.S. keyboard. If you are not, you may find that some of the key commands in your Logic installation do not function as described in this book.

If at any point you find that the key commands don't respond as expected, make sure that the U.S. key command preset is enabled on your Mac by choosing Logic Pro X > Key Commands > Presets > U.S.

Screen Resolution

Depending on your display resolution, some of the project files may look different on your screen when compared to the figures in the book. When you open a project, if you can't see the whole window, move it until you can see the three window controls at the left of the title bar, and Option-click the Zoom button (the third button from the left) to fit the window to the screen.

When using lower display resolutions, you also may have to zoom or scroll more often than described in the book to perform some of the exercise steps. In some cases, you may have to temporarily resize or close an area of the Tracks window to complete an action in another area.

About the Apple Pro Training Series

Apple Pro Training Series: Logic Pro X Advanced Audio Production: Composing and Producing Professional Audio is part of the official training series for Apple Pro applications developed by experts in the field. The lessons are designed to let you learn at your own pace. You'll find that this book explores many advanced features and offers tips and techniques for using the latest version of Logic.

Although each lesson provides step-by-step instructions for creating a specific project, there's room for exploration and experimentation. Try to follow the book from start to finish, or at least complete the lessons in each part of the book in order. Each lesson concludes with a review section summarizing what you've covered.

For a complete list of Apple Pro Training Series books, see the ad at the back of this book, or visit www.peachpit.com/apts.
Apple Pro Training and Certification Program

The Apple Pro Training and Certification Program is designed to keep you at the forefront of Apple digital media technology while giving you a competitive edge in today’s ever-changing job market. Whether you’re an editor, sound designer, special effects artist, or teacher, these training tools are meant to help you expand your skills.

For more information, go to training.apple.com.

Resources

*Apple Pro Training Series: Logic Pro X Advanced Audio Production: Composing and Producing Professional Audio* is not intended as a comprehensive reference manual, nor does it replace the documentation that comes with the application. For more information about Apple Logic Pro X, refer to these sources:

- Logic Pro Help, accessed through the Logic Pro X Help menu, contains a description of most features. Other documents available in the Help menu can also be valuable resources.

This lesson takes approximately 60 minutes to complete.

Build new sampler instruments from audio regions
Assign pitch mapping and tuning to zones
Create loop points for sustaining sounds
Use groups to assign common parameters to multiple zones
Use filters and modulation to change the character of sampled material
Route output of specific groups for individual processing
A sampler is an extremely versatile tool. Essentially, it allows you to map digital audio files, or *samples*, across pitch ranges for triggering via MIDI. It does this by dynamically changing the playback speed of the samples in real time to match the pitch specified by the MIDI note value.

Individual samples are referenced and mapped in a *sampler instrument*. In this lesson, you will explore the abilities of the EXS24 by creating unique sampler instruments using specific audio regions from the Tracks area.
Creating Sampler Instruments

Traditionally, new sampler instruments are produced by first creating a blank sampler instrument, and then adding and mapping individual samples one by one, building the instrument from the ground up. However, Logic can also use a single command to automatically create a new EXS24 track loaded with a new sampler instrument wrapped around a selected audio region in the Tracks area. With this feature, extending the creative possibilities of audio files is especially easy, placing triggering and processing capabilities right under your fingertips.

1. Choose File > Open.

2. Open Music > Advanced Logic X_Files > Lessons > 04_EXS24_Start.logicx.

3. Use the Mute tool to unmute the Vox Note region on Track 1.

4. Play the project, listening to the Vox Note audio region. You will use this recording of a singer holding a single pitch for your first sampler instrument.

5. Stop playback.

6. Go to the beginning of the project.

7. In the Tracks area, select the Vox Note region, if necessary.

8. From the Track menu, choose Convert Regions to New Sampler Track.
In the Convert Regions to New Sampler Track dialog, you can set how the selected audio region will be initially mapped in the new sampler instrument. Samples are mapped in zones, which contain settings that control how the sample is played back, including key ranges.

![Image of Convert Regions to New Sampler Track dialog]

9 Select Create Zones From Regions, if necessary.

A single zone will reference the Vox Note audio region (as outlined at the bottom of the dialog).

You can also set the pitch range of the created zone, as specified by the Trigger Note Range menus (low to high). Because only a single audio region was selected (you can also select multiple regions), it will utilize only the lowest trigger note to map the region.

10 From the first Trigger Note Range pop-up menu, choose C3 (60) to create a new zone at C3, right in the middle of the keyboard.
11 Click OK.

A new EXS24 track (named Vox Note) is created below the original track, along with a new MIDI region. This new region contains a held C3 note that triggers the newly mapped audio file for the same duration as the original audio region. Note that the original region is muted. The new MIDI region, in effect, replaces the original one in the arrangement.

12 Play the project while listening to the new Vox Note MIDI region played through the EXS24. The playback sounds identical to the original.

This new zone will be automatically velocity mapped so that the harder you strike the key, the louder the sample will play.

13 Press C3 on your MIDI keyboard at varying velocities and listen to the results.

The Vox Note audio file plays as long as you hold down the key, while changing volume (amplitude) depending on how hard you hit the key.

**Using the EXS24 Instrument Editor**

Let’s take a look inside the newly created sampler instrument with the goal of exploring the creative potential offered by the EXS24. You edit Sampler instruments in the EXS24 Instrument Editor, which is accessible from the EXS24 interface.

1 In the inspector, double-click the EXS24 in the channel strip to open the EXS24 interface.
The EXS24 Parameter window opens with the newly created sampler instrument, Vox Note, displayed. You will be working with the parameters in this window later in the lesson; but for now, you will use it to quickly access the EXS24 Instrument Editor.

2 Click the Edit button.

The EXS24 Instrument Editor opens.
To save some screen real estate, close the EXS24 Parameter window (but not the EXS24 Instrument Editor).

The EXS24 Instrument Editor has two views: Zones and Groups. You are currently looking at the Zones view (more on Groups later), as indicated by the selected button at the upper left.

The top portion of the EXS24 Instrument Editor is called the Parameters area, and it displays the settings of each sample referenced by the sampler instrument. The bottom portion of the window displays how each sample is mapped to various pitches, as represented by the keyboard at the bottom of the window. As you can see, a new zone named Vox Note.1 was created, mapped to C3 on the keyboard.

When you create a sampler instrument with the Convert Regions to New Sampler Track command, the zone created is without range—that is, mapped to only a single pitch.
You can, of course, extend the zone's range to map the audio file to multiple pitches, either by changing settings in the Key Range columns of the Parameters area, or by directly dragging the zone in the lower area.

4 In the Key Range parameters, double-click the Hi field and enter c4. Press Return.

![Key Range parameters](image)

The zone extends in range to the right, from C3 to C4.

5 In the lower area of the EXS24 Instrument Editor, drag the zone's left border toward the left, extending the range to C2.

![MIDI keyboard](image)

6 Play the C2 to C4 keys on your MIDI keyboard, listening to the result.

The pitch (and speed) of the sample shifts up and down, mapped in relation to your MIDI keyboard input.

**NOTE** ▶ You can also create new sampler instruments by choosing New from the EXS24 Instrument Editor's Instrument menu, or by clicking the Edit button on the EXS24 interface when an instrument isn't currently loaded. Doing so creates a blank sampler instrument in which you can manually add zones by choosing New Zone or Load Multiple Samples from the Zones menu. You can also create new zones by dragging audio files from the Project Audio, Media, or All Files Browser, or even the Finder.

If you have perfect pitch, you might have noticed that the sung note is a little flat compared to standard tuning (A440). It wouldn't be a problem if this were the only instrument used in the project, but if other instruments will be played at the same time, it would sound out of tune. Using the zone's Pitch parameters in the Instrument Editor, you can compensate for tuning discrepancies in Coarse or Fine degrees. (Coarse equals semitones, and Fine equals cents, or 1/100th of a semitone.)
The best way to tune a zone by hand is by inserting a Tuner plug-in on the EXS24 channel, monitoring the results as you adjust parameters.

7 Click the Audio FX slot of the new Vox Note (EXS24) channel, and choose Metering > Tuner > Stereo to open the Tuner.

8 While watching the Tuner readout, hold down the C3 key on your MIDI keyboard and drag the zone’s Fine parameter upward to about 28 cents. (The Tuner’s readout will bob around the 12 o’clock position.)

![Tuner Window](image)

The sample plays in tune relative to standard tuning.

9 Close the Tuner window.
Creating Loop Points

Looping is a technique that stems from the days when samplers had tiny memory stores (by today’s standards) in which to load samples. Many sounds start off with complex attacks but soon settle into a more or less steady waveform. By repeating this “settled” area, a sample can be sustained indefinitely without using up limited memory space. Even with modern software samplers that have access to gigabytes of memory (like the EXS24), looping is a useful technique to create sustaining sounds out of samples that are otherwise quite short, such as the audio file you are working with in this exercise.

By default, this editor displays only some of the Zone parameters, while hiding others, including the Loop parameters. You can select the parameters you want to display in the View menu.

1. From the local View menu, choose View All.

![View menu with View All selected]

All Zone parameters are displayed, including the Loop parameters.

![Loop parameters]

**NOTE** ▶ Depending on the size of your EXS24 Instrument Editor window, you might need to scroll to the right to view the Loop parameters.
To enable looping, you first need to select the Loop On option.

2 In the Loop parameters, select Loop On.

Although you could enter start and end times (by sample number) in the parameters area, doing so would be arbitrary and counterintuitive. Selecting an area on the waveform itself using the Audio File Editor is much easier.

3 In the Audio File parameters for the zone, click the disclosure triangle to the right of the audio file name and choose “Open in Sample Editor.”

The Audio File Editor opens, displaying the referenced audio file, *Vox Note.aif*.

**NOTE** You most likely will need to expand the Audio File Editor window to complete the following exercise. If you have limited screen real estate, you can minimize the EXS24 Instrument Editor window, temporarily storing it in your Dock.

**TIP** Double-clicking an audio file in a zone also opens the audio file in the Audio File Editor.
You can set the Audio File Editor’s timeline to display time using various units of measurement, depending on which is most useful for the task. For example, when setting loop points, you may find it most helpful to view the timeline in samples (1 sample = 1 ÷ sample rate per second.) That type of timeline setup corresponds to the numerical display in the EXS24 Instrument Editor.

**NOTE** Don’t confuse samples (as a measurement of time) with audio samples, as mentioned earlier in the chapter. The latter is another way of saying “digital audio files,” while the former refers to the tiny components that make up a digital waveform.

4 From the local View menu, choose Samples, if necessary.

![](image)

The timeline is now displayed in samples.

The trick to setting loop points is to find a sustaining portion in the audio file you can repeat without interruption. To make smooth edits, you must make selections that do not interrupt the waveform above or below the zero axis (thereby creating an audible click). When you enable “Snap Edits to Zero Crossings” in the Audio File Editor, all new selections will be justified to the nearest point the waveform crosses the zero axis.

5 If not set already, choose Snap Edits to Zero Crossings from the local Edit menu.

6 Using the help tags, select an area from approximately 28800 to 91900 samples (refer to the following figure).
You can audition your selection by selecting the Prelisten and Cycle buttons at the top of the Audio File Editor.

7. Click the Prelisten and Cycle buttons to listen to your selection looping.

8. Click the Prelisten button to stop playback.

**Tip** Your loop points may sound a bit rough at first, but with further massaging, you can create a smoother result. You do this by zooming in on the start and end loop points and fine-tuning the selection while auditioning the results.

Now that you’ve identified the area you want to be looped, you need to set the start and end loop points to the zone in the EXS24 Instrument Editor.

9. From the Audio File Editor’s local Edit menu, choose Selection > Sample Loop.

The Sample Loop lane in the Audio File Editor displays the selected area in orange.
10 Close the Audio File Editor.

The results of your selection appear in the Loop parameters of the EXS24 Instrument Editor.

<table>
<thead>
<tr>
<th>Loop</th>
<th>On</th>
<th>Start</th>
<th>End</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>✔</td>
<td>28791</td>
<td>91935</td>
</tr>
</tbody>
</table>

11 Hold down C3 on your MIDI keyboard, listening to the result.

The sample plays, now looping the selected area for as long as you hold down the key.

To aid you in smoothing out the repeating loop’s start and end points, you can apply a short crossfade (much as you would smooth region transitions in the Tracks area).

12 In the Loop parameters, double-click the Xfade field and enter 30. Press Return.

<table>
<thead>
<tr>
<th>Loop</th>
<th>On</th>
<th>Start</th>
<th>End</th>
<th>Tune</th>
<th>XFade</th>
<th>E.</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔</td>
<td></td>
<td>28791</td>
<td>91935</td>
<td>0</td>
<td>30</td>
<td></td>
</tr>
</tbody>
</table>

An option is also available to make the crossfade equal powered, which creates an exponential curve with a 3 db volume boost in the middle to compensate for the volume dip that normally occurs in a linear crossfade.

13 In the Loop parameters, select the E. Pwr option.

<table>
<thead>
<tr>
<th>Loop</th>
<th>On</th>
<th>Start</th>
<th>End</th>
<th>Tune</th>
<th>XFade</th>
<th>E.</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔</td>
<td></td>
<td>28791</td>
<td>91935</td>
<td>0</td>
<td>30</td>
<td></td>
</tr>
</tbody>
</table>

14 Hold down a C3 on your MIDI keyboard, listening to the result.

The sample plays, smoothly looping the selected area for as long as you hold down the key.
Using the Parameter Window

After a sampler instrument is loaded, the triggered sounds are further refined and processed by the global playback parameters located on the interface of the EXS24 itself. These parameters, which are nearly identical to the sound processing functionality of a synthesizer, allow you to further shape your sampler instrument sounds.

1. In the EXS24 Instrument Editor window, click the EXS24 button.

![EXS24 Button]

The EXS24 Parameter window (interface) opens. It offers a convenient way to access the EXS24 playback parameters without having to go back to the channel strip.

2. Close the EXS24 Instrument Editor.

A Save dialog appears.

![Save Dialog]

3. Click Save.

Now look at the EXS24’s interface. Note that the EXS24 shares many interface characteristics with the ES2 synthesizer covered in Lesson 3. It has filter, output, modulation routing, and modulation source sections in similar places in the interface.
In this exercise, you will use the amplitude envelope to change the Vox Note sampler instrument's character to that of a swelling choir-like pad that decays slowly. In the EXS24, Envelope 2, which is hardwired to amplitude, controls the dynamics of how the sound is shaped over time for each key pressed.

4 In the controls for Envelope 2, drag the bottom half of the Attack slider upward to about 820 ms.
You can split the Attack controls of both Envelopes 1 and 2 to create a range. This intensity range is modulated via note velocity, wherein high values trigger the sound more quickly (represented by the lower half of the control), and low values trigger the sound more slowly (represented by the upper half of the control).

5. In the controls for Envelope 2, drag the Release slider upward to about 820 ms.

6. Hold down a chord between C2 and C4 on your MIDI keyboard, listening to the result. You should hear a swelling, sustained choir sound, based on the original audio file, Vox Note.aif.

7. From the preset menu in the EXS24 window, choose Save As.

8. Name the preset Vox Note and click Save.

9. Close the EXS24 window

Creating Multiple Zones from Region Transients

In the previous exercises, you created a single zone sampler instrument from an audio file in the Tracks area. Using a similar technique, you can create a sampler instrument with multiple zones based on detected transients in the audio file. This is especially useful when dealing with rhythmic material such as drum and percussion loops that have clear transients.

In the following exercises, you will create a new sampler instrument from a basic drum loop and explore ways to extend and transform the sound using the EXS24 playback parameters and routing flexibility.

1. Use the Mute tool to mute the new Vox Note region (Track 2).

2. Select the Basic Drums track (Track 3).
3 Unmute the Basic Drums region on Track 3.

4 Play the project, and listen to the Basic Drums region to become familiar with the material.

5 From the Track menu, choose Convert Regions to New Sampler Track. The Convert Regions to New Sampler Track dialog appears.

6 Select Create Zones From Transient Markers.

![Create Zones From: Regions](Regions) ![Create Zones From: Transient Markers](Transient Markers)

**NOTE** ▶ When you create zones from transient markers, Logic performs a quick transient detection similar to the one performed when you first activate Flex on a track. The number of detected transients appears in the info area at the bottom of the Convert Regions to New Sampler Track dialog.

7 Click OK.

A new EXS24 track (also named Basic Drums) is created, along with a new MIDI region. This new region contains multiple note events that trigger each of the created zones in order, and for the same duration as the original audio region, thereby replacing the original audio region in the arrangement.

![Basic Drums](Basic Drums)

**NOTE** ▶ This operation is similar to using the Slicing Flex mode, wherein an audio region is chopped up according to its transients.
8 Play the project, listening to the new Basic Drums MIDI region played through the EXS24. The playback sounds identical to the previous version.

9 In the inspector, double-click the EXS24 in the channel strip to open the EXS24 interface.

10 Click the Edit button, located at the upper right.

The EXS24 Instrument Editor opens, displaying the multiple zones created from transients.

![EXS24 Instrument Editor](image)

As you can see in the Parameters area, each transient from the original audio file is mapped chromatically to MIDI pitches C3 through G3.

11 Play the C3 through G3 keys on your MIDI keyboard, listening to the results.

When playing the associated MIDI pitches on the keyboard, you hear each individual slice. However, the slice plays only for as long as you hold down the key, and it can sound truncated if you release the key before the slice plays in its entirety. To allow the sample to play its complete length irrespective of the key release, you need to enable 1Shot in the Zone parameters.
12 With the EXS24 Instrument Editor window having key focus, press Command-A to select all of the zones.

13 On any of the selected zones, select the 1Shot checkbox to select it for all.

![Image of 1Shot checkbox]

**NOTE ▶** You can create 1 Shot zones automatically when converting audio files to sampler tracks by selecting Create ‘1 Shot’ Zones in the Convert Regions to New Sampler Track dialog.

14 Play the C3 through G3 keys on your MIDI keyboard, and listen to the results.

The slices play in their entirety.

Although this method provides an effective way to trigger the drums as a performance instrument, let’s explore additional playback parameters in the EXS24 Instrument Editor to further process the sound.

15 Click in the background of the EXS24 Instrument Editor to deselect all zones.

16 In the Parameters area, Command-click the zones mapped to C#3, D#3, and G3 to select them.

**TIP ▶** To use your MIDI controller to select zones, choose Zone > Select Zone of Last Played Key.
17 Select the Reverse checkbox for one of the selected zones to enable it for all selected zones.

18 Play the C#3, D#3, and G3 keys on your MIDI keyboard, listening to the result. The samples play in reverse.

19 Close the EXS24 Instrument Editor window.

20 In the dialog that appears, click Save.

**Using Filters and Modulation to Process the Sound**

Just as you used the ES2 synthesizer to process the oscillators’ signal, you can use the EXS24 filter and modulation options to process a sampler instrument you created. In fact, the EXS24’s filter and modulation routers directly mirror the ones in the ES2, with the exception of offering only a single filter, instead of a pair.

The filter in the EXS24 is a multimode filter that includes high-pass, low-pass, and band-pass modes. To take advantage of its sound-shaping properties, you need to turn it on.

1 Click the filter on/off button located at the right side of the filter section.
NOTE ▶ The on/off switch for this filter enables you to quickly audition sounds with and without the filter’s influence. Also note that when the filter is active, Logic uses more processor power, so switch off the filter when you don’t need it.

Now that the filter is turned on, you can apply filter settings to shape the sound.

2 Do the following with the EXS24’s filter settings (as in the following figure):

▶ Click the 6 db low-pass (LP) filter mode/slope button to gradually attenuate frequencies above the cutoff frequency.

▶ Drag the Cutoff knob to about 68%.

▶ Drag the Resonance knob to about 45% to accentuate the cutoff frequency by applying a gain boost.

▶ Click the Fat button to retain the low frequencies that are naturally diminished by high-resonance settings.

▶ Drag the Drive knob to about 20% to distort the filter and add harmonics.

Now that you’ve adjusted your filter settings, it’s time to hear the result.

3 Play the C3 through G3 keys on your MIDI keyboard, listening to the results of the filter settings.

You can further expand the filter’s sound-shaping properties by applying modulation to the cutoff frequency. The goal is to create a surging filter sweep that is timed to the tempo of the song. You can do so by using the EXS24’s modulation router, which is nearly identical to the ES2’s modulation router except that it calls a parameter that is changed dynamically the “destination” instead of the “target.”
4 In the third (empty) slot in the modulation router, choose filter cutoff (Flt Cutoff) as the destination (Dest), and LFO1 as the source (Src).

![Modulation Router](image1)

5 Drag the Intensity slider to about +7.7%.

![Intensity Slider](image2)

6 Select the top sawtooth setting for LFO1’s waveform.

![Waveform](image3)

7 Drag LFO1’s Rate knob to the left to 1/8.

![Rate Knob](image4)

You now have a filter sweep for every eighth note, regardless of the project tempo.

**NOTE** The EXS24’s LFO1 is polyphonic with its own envelope generator, just like the ES2.

Now you’ll test your modulation routing. Because it’s tempo dependent, let’s listen to it playing in the Tracks area.
8 In the Transport bar, click the Cycle button.

9 Play the project, listening to the result.

You should hear a sweeping, pulsing, swelling drumbeat that is significantly transformed from the original.

10 Stop playback.

While the loop was playing, you might have noticed that the EXS24 was distorting, and the channel volume pushed well into the red. This is because of the extra gain introduced by boosting the Drive and Resonance controls. You can recover a little headroom by lowering the EXS24 Volume control, located to the far right of the interface.

11 Drag the Volume knob downward to a value of –7 db.

---

**Using Groups**

In the EXS24 Instrument Editor, you can organize zones into groups to apply common parameters to multiple zones simultaneously. Groups contain many of the same parameters you use in zones, but they also offer some unique parameters. For example, you can offset both the filter settings and the envelopes, which allows you to create different cutoff and resonance values for different zones.

In the sampler instrument you created, the low-pass filter cut out the high frequencies of all samples. By using groups, you can, in effect, apply a different cutoff frequency for just the snare hits.

1 In the EXS24 interface, click the Edit button to open the EXS24 Instrument Editor.
2 From the local menu, choose Group > New Group.

A new group, named Group #3, appears in the Zones column.

NOTE ► In addition to the newly created group, the Zones column displays All Zones, Ungrouped, and Basic Drums groups. The All Zones group contains all zones, regardless of their assignments. The Ungrouped group contains only zones that have no assignment whatsoever. The Basic Drums group, created by default when you imported the samples into the EXS24 Instrument Editor, contains all the slices created using the Convert Regions to New Sampler Track setting.

3 In the Zones column, double-click the new group name (Group #3), and enter Filter. Press Return.

To display the newly created group's parameters, you need to switch to Groups view.

4 Click the Groups view button.
The group parameters appear.

**NOTE**  By default, the editor displays only some of the group parameters, while hiding others. As you did with zones in an earlier exercise, while in Groups view you can select the parameters that will appear in the View menu.

5 In the Filter Offsets parameters, double-click the Cutoff field and enter –5 to lower the filter cutoff frequency for any zone assigned to this group. Press Return.

Now that you created and modified the group, you'll assign the zones to it using the Zones view.

6 Click the Zones view button.
You might be asking yourself, “Where did the zones go?” Not to worry; you are currently viewing the Filter group, which does not yet have any zones assigned to it.

7 Click the All Zones group to display all zones.

You can easily assign zones to groups by dragging them onto the groups in the Zones column.

8 Command-click the zones mapped to D3 and F#3 to select them.

9 Drag the selected zones to the Filter group.

10 In the Zones column, select the Filter Group.

The two zones you added appear.

11 Play the project, listening to the result.

The snare samples mapped to D3 and F#3 have a slightly different filter cutoff frequency, thereby changing their sounds.
Routing Individual Sounds for Processing

As if the options offered by the EXS24's modulation and filter sections weren't enough, Logic allows you to further process the EXS24 sound by placing plug-ins into the signal chain. When you do so, the entire EXS24 signal is processed. Although processing the entire signal normally isn't a problem, in some instances you may want to apply separate processing to individual zones in a sampler instrument. To do so, you need to isolate the zone or group on its own mixer channel for individual processing.

Fortunately, the EXS24 allows you to route individual sounds through separate virtual "outputs" to accomplish just that. These routings are selected by the Output menu in the Mixer parameters in either the Zone or Group parameters.

1. Click the Groups view button.

2. Click the Output field for the Filter group (currently set to Main), and choose 3-4.

   ![Output settings example]

   **NOTE** ▶ The selections with dashes separating numbers represent stereo routings, and the selections with single numbers (without dashes) represent mono routings.

3. From the local Instrument menu, choose Save.

   To use this special function, you need to instantiate the EXS24 as a multi-output instrument. So far you've been working with the EXS24 as a stereo instrument and have done quite a bit of work modifying the zones and groups. Luckily, Logic allows you to keep all your current settings when changing from stereo to multi-output instantiations.

   **NOTE** ▶ Logic transfers all settings and content contained in a software instrument when you switch modes (mono, stereo, multi-output, and 5.1).

4. Close the EXS24 Instrument Editor window.

5. Click the Mixer button to open the Mixer.
On the Basic Drums channel strip (Track 4), click and hold down the mouse button over the Instrument slot to open the Instrument Plug-in menu. Choose EXS24 (Sampler) > Multi Output.

The EXS24 interface opens after reloading the associated samples and current settings.

If necessary, move the EXS24 window so that you can see the EXS24 Basic Drums channel strip (Track 4).

Just under the Solo button, click the small + (plus sign) button on the EXS24 Basic Drums channel strip (Track 4).
A new Aux 1 channel strip is created immediately to the right of the EXS24 Basic Drums channel strip (Track 4). It will be the receiving channel for your Filter group. By default, Logic creates an aux channel with the default stereo input of 3-4 for the associated multi-output instrument (in this case, the EXS24).

9 Play the project, stopping playback after you’ve had a chance to hear the output of the Aux 1 channel.

The zones assigned to the Filter group play through the Aux 1 channel, while the remaining zones play through the EXS24 Basic Drums channel (Track 4).

TIP This technique works well for drum sampler instruments that need separate compression, EQ, and ambience treatments for individual drums (kick, snare, and so on).

Now that the snare slices are isolated on their own mixer channel, you can insert plug-ins or apply send effects for further processing without affecting the other slices in the sampler instrument. In the following steps, you will send the snare slices through a simple Echo plug-in to create rhythmic echoes.

10 Click the Aux 1 channel’s top insert slot, and choose Delay > Echo > Stereo.

The Echo plug-in is instantiated, and its interface window opens.
11 Click the Time menu, and choose 1/8 T to set the repeat time to eighth-note triplets.

12 Drag the Wet slider down to 23% to lower the repeats’ volume level so they do not overpower the original signal.

13 Play the project, listening to the effect of all the EXS24 programming you’ve done in the previous exercises.

   The result is a surging, shuffling, processed drum loop, quite abstracted from the original audio file.

14 From the Echo plug-in’s preset menu, choose Save As.

15 Name the preset *Snare Repeats* and then click Save.

   To gain perspective on just how much you changed the original loop, let’s finish by listening to it.

16 Close both the Echo and EXS24 windows.

17 Close the Mixer.

18 Using the Mute tool, select the Basic Drums.1 region on Track 3, thereby unmuting the original region.

19 In the Transport bar, click the Solo button to enable it.

20 Play the project.
While the project is playing, select the original Basic Drums audio track (Track 3) and EXS24 Basic Drums software instrument track (Track 4) alternatively to solo them.

Stop playback.

In the Transport bar, click the Solo button to disable it.

**Lesson Review**

1. Where are individual samples referenced and mapped?
2. Where do you find the settings that determine how a sample is played, including key ranges?
3. Which tuning parameter in the EXS24 Instrument Editor is used to tune by cents: Coarse or Fine?
4. Are loop points set in zones or groups?
5. Which EXS24 Instrument Editor parameter is used to smooth out transitions between the end points and start points of a loop?
6. How are groups used in the EXS24 Instrument Editor?
7. Are filter and envelope offsets set in zones or groups?
8. What do multi-output instruments do?

**Answers**

1. Samples are mapped in sampler instruments.
2. Zones contain the settings for sample playback and key range.
3. The Fine parameter is used to tune by cents.
4. Loop points are set in zones because they refer to specific samples.
5. The Xfade parameter allows you to assign a crossfade between the end and start points of a loop, making it smoother.
6. Groups are used to assign common parameters to multiple zones.
7. Filter and envelope offsets are set in groups.
8. Multi-output instruments (such as Ultrabeat and EXS24) can route individual sounds to separate channel strips for isolation or further processing.
Index

Symbols and Numbers

., (comma), positioning playhead, 207
., (period), positioning playhead, 207
5.1 format
 assigning audio interface outputs for surround sound, 420–422
downmixing, 445
format options for surround sound, 420
setting surround format, 422
7.1 format, 420

A
AAC files, choosing audio format, 582
AC3 (Dolby Digital), 448
Acoustic guitar. See also Guitars
 automating mutes, 380–381
copying automation data, 384–388
snapping automation data to timeline, 381–384
switching contents of plug-in window, 334–336
Adaptive mixer, 323
Adding Scene Cuts function, 571–572
ADT (Automatic Double Tracking), 63
Advanced audio editing
 activating/deactivating groups, 259–261
applying crossfades to multiple regions, 240–242
configuring edit groups, 256–259
creating comps, 250–255
creating new parts from existing, 245–246
editing groups with Flex editing, 261–263
editing using mixer groups, 255–256
fixing clicks, 242–245
overview of, 235
packing parts into take folder, 246–250
quantizing drums with phase-locked editing, 263–265
repairing drums with marquee transient, 265–269
replacing drums, 269–276
review, 269–276
smoothing transitions with crossfades, 236–239
Advanced MIDI editing
 adjusting project feel, 288–289
aliases, 280–283
altering articulation, 289–290
altering MIDI events, 283
applying new transform sets, 311–312
arpeggiating chords, 296–298
correcting and modifying rhythm, 290–296
creating new transform functions, 305–311
modifying region velocity, 285–287
overview of, 279
region parameters, 283
review, 315
selecting MIDI events, 300–302
separating MIDI events, 312–314
template parameters in, 298–300
transposing regions, 283–285
working with transform sets, 302–305
Alerts, 19
Aliases, in MIDI editing, 280–283
All Files Browser, 321
All view, Mixers, 322, 326–328
Alter Existing Randomly, applying to triggers, 187
Alter selection, in Offset shortcut menu, 191
Alternative option, File menu, 217–218, 232
Amplifiers
 assigning outputs for surround sound, 420–422
built-in, 364
Amplitude envelope, 131–132
Analog waveforms
 oscillators and, 83–88
Ultrabeat features, 168
Analyse Transients option, in Beat Mapping pop-up, 75–76
Animation, string animation in Sculpture, 151
Apple Loops, using with touch tracks, 493–497
Apple Pro Training Series: Logic Pro X: Professional Music Production (Nahmani), 37
Apple QuickTime
 adding scene cuts, 571–573
playback control, 569
spotting (identifying) where to add music, 569–571
synchronizing video and Logic using SMPTE timecode, 566–568
for video playback, 563
Arpeggiating chords, with Q-Flam, 296–298
Arpeggiator MIDI plug-in, 465
Arpeggiator objects
 cabling to transformer object, 480, 482
changing track objects, 475–476
creating, 481
dragging output to cable switcher, 483
using, 465–469
Arrange area, global tracks, 68, 70
Arrange track list
 changing track assignment, 471–472
configuring objects for use in, 466
placing delay line object in, 473
Arrange window, Region parameter, 488
Arrangements
 comparing, 231–232
creating markers, 206–210
defining marker positions, 210–212
extending, 227–231
global edits, 218
indexing material, 218–221
inserting space, 221–223
isolating material, 199–200
Marker Lists and, 214–216
naming and coloring markers, 212–214
navigating, 198, 214
omitting section during playback, 200–201
overview of, 197
playback using specialized commands, 203–205
playback with Bar ruler, 198–199
playback with Marquee tool, 201–203
removing material, 223–227
review, 232–233
saving alternatives, 216–218
Arrow keys, playing selections with, 266–267
As Text option, Style menu, 485
Assignment section, of Ultrabeat interface, 167
Asymmetry control, in Ultrabeat, 169
Attack slider, envelope generators, 103, 105
Audio
adding to picture, 569–571
advanced editing. See Advanced audio editing
audio editing compared with MIDI editing, 279
channels for, 319
clipping effect, 339
creating post-production, 560–563
creating/configuring tracks, 5–7
exporting, 582–584
formats, 582
preferences, 420
prevalence of surround sound, 419
processing audio input, 175
quantizing, 49–53
rendering, 374–376
routing audio signals, 349
samples. See Samples (audio)
shifting and stretching, 46–49
synchronizing audio events to SMPTE positions, 577–579
Audio File Editor
defining transient markers, 267
editing transient markers, 53–55
enabling looping, 126–129
fixing clicks or pops, 242–245
Audio FX slot, on new Vox Note channel, 124
Audio interfaces. See also Interfaces assigning outputs for surround sound, 420–422
built-in amplifiers, 364
creating headphone mix using pre-fader sends, 361–364
labeling inputs/outputs, 364–367
output channels in, 327
Audio regions. See also MIDI regions;
Regions applying crossfades to multiple regions, 240
beat mapping, 74–76
changing name of, 59
Convert Regions to New Sampler Track, 118–119
Create Zones From Regions, 119
fixing clicks or pops, 242–245
manipulating timing of, 35–36
manipulating with Flex Time, 37–38
muting/unmuting, 75, 260–261
renaming audio regions, 249
Audio settings, Project Setting window, 422, 565
Audio Track Editor
doubling parts, 60–61
editing audio selections, 55
enabling Flex options, 59–60
formant correction, 62
timing adjustment, 62–63
Audio waveforms. See Waveforms
Automatic Double Tracking (ADT), 63
Automation
applying to multiple tracks simultaneously, 390–393
assigning vocal track to VCA group, 393–396
bending automation curves, 389–390
copying automation data, 384–388
editing automation data, 380–381
importing automation data, 321
of parameters in Step mode, 188–191
showing/hiding automation data, 375
snapping automation data to timeline, 381–384
trimming automation values, 396–398
Automation curve, 389–390
Automation mode
Group Settings window, 391–392
Latch option, 395
Read option, 395, 398
Touch option, 396–397
Automation Parameter pop-up menu, 388
Automation Snap Offset, 383
Aux channels
Create New Auxiliary Channel Strip, 368
creating headphone mix using pre-fader sends, 361–364
format options (stereo, mono, surround), 358
B
Balance analyzer, MultiMeter plug-in, 443–444
Balance control
panning stereo tracks, 331
working with surround sound, 424
Band pass (BP) filters
in EXS24, 136
multimode filters, 96
in Ultrabeat, 179
Ultrabeat noise generators and, 172
Band reject (BR) filters
multimode filters, 96
in Ultrabeat, 179
Banjo tracks
bending automation curves, 389–390
channel strip for, 328
Bar ruler
creating cycle areas, 199–200, 219, 223, 227
jumping to marker positions, 208
navigating projects, 207–208
playing arrangements, 198–199
playing movies, 568
scrubbing audio, 243–244
skip cycle area and, 201
Bars, Beat Mapping track, 69
Bass Clarinet tracks
editing transient markers, 53–55
Groove templates, 57–58
Bass staff style, Style menu, 517
Bass Synth track, altering articulation of, 289–290
Bass tracks
adjusting center and LFE levels, 428–429
working with surround sound, 423–425
Beat Mapping track
audio regions, 74–76
checking, 73–74
creating tempo changes, 67–69
markers and, 571
MIDI regions, 69–73
Beat patterns, in Ultrabeat, 181
Beats, tempo and, 69
Bending automation curves, 389–390
Bit depth, choosing, 583
Blend slider, on synthesizer filter, 92, 97–98
Body EQ, 158
Bouncing
constructing string quality, 155–156
creating master multichannel file of surround mix, 446–448
Region in Place, 371–374
Track in Place, 375–376
BP filters. See Band pass (BP) filters
BR filters. See Band reject (BR) filters
Broadcast WAVE files (BWF), 575–577
Browsers
All Files Browser, 321
Loop Browser, 493–494
Buttons, for switching between modes, 410–412
BWF (Broadcast WAVE files), 575–577
Bypass Effects Plug-ins, 373, 376
Bypass parameter, modulation and, 104

C
Cable switcher objects, 483–488
Cables
connecting arpeggiator to transformer object, 480, 482
connecting delay line object to monitor object, 473
connecting memorizer object to monitor object, 470
output of object to another object, 464–465
Carrier oscillator
in frequency modulation, 88–89
in ring modulation, 90–91
Center channel, adjusting surround sound, 427–429
Channel EQ plug-in
acoustic guitar example, 334–335
changing plug-in locations, 337–338
multi-mono insert effects, 437–440
Channel strips
accessing in inspector, 11
Create New Auxiliary Channel Strip, 368
filters, 324–325
importing, 320–322
panning stereo tracks, 331–333
Select All, 362
selecting/grouping from drum track, 256–257
settings for control assignments, 405
Channels
analyzing in surround mix, 442–444
assigning controls, 401–405
assigning outputs for surround sound, 421–422
assigning to Mixer groups, 339–344
displaying multiple, 326–328
displaying single, 328
filter buttons, 324–325
grouping to share automation modes, 390
highlighting in Tracks area and in Mixer, 323
importing, 321
isolating speaker output, 441–442
master channels. See Master channels
for MIDI, audio, and software instruments, 319
parallel compression, 356–361
selecting in Mixer, 423–424
Ultrabeat output capacity, 191
Charts
creating chord charts, 528–531
creating chord grids, 532–536
Chord memorizer objects
changing track objects, 475–476
creating one-measure MIDI region in, 487
positioning in Environment window, 479
using, 470–472
Chord Trigger MIDI plug-in, 470
Chords
adjusting note length, 510–512
arpeggiating, 296–298
creating chord charts, 528–531
creating chord grids, 532–536
creating complex rhythmic patterns, 465
dragging into score, 509–510
positioning in graphic notation, 508
Clarinet tracks
doubling parts, 58–61
etting transient markers, 53–55
formant correction, 61–62
Groove templates, 57–58
timing adjustment, 62–63
Click & Ports layer, routing MIDI signals, 460
Clips
fixing in Audio File Editor, 242–245
smoothing transitions with crossfades, 236
Clipboard, copying to, 267
Clipping effect, 339
Coarse tuning, correcting pitch discrepancies, 123
Collapse Mode button, Piano Roll Editor, 313
Color
assigning to markers, 212–214
assigning to objects, 465–466
assigning to regions, 249
Comma (,), positioning playhead, 207
Component modeling, in Sculpture, 149
Compressing time, 34–36
Compression, creating parallel compression, 356–361
Compressor plug-in
acoustic guitar example, 335–336
changing plug-in locations, 337–338
side chain techniques, 355
Comps, creating, 250–255
Continuous control number (cc#), 406
Control bar
customizing, 8–10
Metronome button, 53
Control key, modifier keys for working with functions, 24
Control surfaces. See also MIDI controllers
assigning buttons for switching between modes, 410–412
assigning channel controls, 401–405
assigning transport controls, 399–401
changing fader banks, 412–415
controlling live automation, 380
creating zones and adding modes for, 407–410
mapping controls to multiple parameters, 405–407
overview of, 398
Controller Assignments window
changing fader banks, 412–415
closing, 405
creating new modes, 408–410
creating new zones, 408
Learn mode, 403–405
mapping controls to multiple parameters, 406–407
Mode Change option, 411
viewing assignments, 402
Controllers. See MIDI controllers
Control/Option key, modifier keys for working with functions, 24
Control/Shift key, modifier keys for working with functions, 24
Convert Regions to New Sampler Track
converting audio regions to sampler instruments, 118–119
creating multiple zones from region transients, 133
creating new sampler instruments, 122
Convert > Loops to Regions, Edit menu, 541
Convert > MIDI Loops to Aliases, Edit menu, 281
Copy/Paste, copying automation data, 384–388
Create Marker button, on Marker track header, 207–208
Create Markers From Regions, 210
Create Zones From Regions, 119
Create Zones From Transient Markers, 133
Crescendo effect, 389–390
Cross-fades
adjusting, 58
adjusting parameter for, 66
applying to multiple regions, 240–242
loop parameters and, 129
Quick Swipe Comping and, 252
smoothing transitions with, 236–239
between synthesizer filters, 92
Cue sheets, 573
Cut/Insert Time, Edit menu
Cut Section Between Locators, 224, 226–227
Insert Section at Playhead, 220
Insert Silence Between Locators, 222
Repeat Section Between Locators, 228
Cutoff frequencies
adjusting, 94–96
filter settings, 137
of low-pass filter, 104
modulating for snare drum sound, 172–173
Cutoff knob, controlling frequencies with, 93–94
Cuts, adding scene cuts, 571–573
Cycle area
converting to skip cycle area, 201
creating, 199–200, 219
creating with Bar ruler, 223
dragging to Marker track, 220
Cycle mode
extending arrangements, 227–231
isolating material in arrangements, 199–200
omitting section during playback, 200–201
playing Vox Telephone region, 221
transport controls, 401
turning on/off, 52, 57
Cycle regions, creating, 37
Cymbals, loading samples in Ultrabeat, 176–177
Creating mapped instruments, 542–547
creating parts for printing, 552–556
creating score sets, 548–551
overview of, 541
Drum sounds, with Ultrabeat. See
Ultrabeat instrument plug-in
Drum tracks
activating/deactivating edit groups, 259–261
applying automation to multiple tracks simultaneously, 391–393
applying crossfades to multiple regions, 240–242
configuring edit group for, 256–259
consolidating, 541–542
creating multiple zones from region transients, 132–136
editing using mixer groups, 255–256
flam sounds, 296
panning stereo tracks, 331
parallel compression, 356–361
quantizing, 49–53, 263–265
repairing drums with marquee transient, 265–269
replacing drums, 269–276
routing individual sounds for processing, 144–147
separating MIDI events, 313–314
soloing, 240
working with surround sound, 423–425
Dubbing, creating stems for, 584
Duplicate Track button, 246
Duration
adjusting note length, 510–512
entering notes graphically, 506
Dynamics menu
Compressor > Stereo, 358–359
Region parameter, 286–287
Echo effects, 289
Echo plug-in, 145–146
Edit Decision Lists (EDL)
creating, 573
synchronizing audio events to SMPTE positions, 577–579
Edit groups. See Mixer groups
Edit menu
accessing and viewing commands, 13
Convert > Loops to Regions, 541
Convert > MIDI Loops to Aliases, 281
Cut/Insert Time commands. See Cut/Insert Time, Edit menu
Diatonic Insert option, 507
Join > Regions, 314, 541
Repeat Multiple, 282
Select All, 362, 366
Select > Invert Selection, 300–301
Select > Same Subposition, 301
Select > All Following of Same Track, 311
Separate MIDI Events > By Note Pitch, 314
Time Stretch, 36
Trim, 230, 302
Faders
assigning channel controls, 401–405
changing fader banks, 412–415
changing without affecting other
channels, 344–346
creating headphone mix using pre-fader sends, 361–364
mapping controls to multiple
parameters, 405–407
positioning send controls, 356
trimming automation values, 396–398
VCA fader, 394
Fat setting
adjusting high resonances, 94–95
EXS24 filter settings, 137
File menu
Alternative option, 217–218, 232
creating templates, 4–5
importing Logic projects, 321
importing project settings, 30, 312
New option, 560
Open option, 82
Save As option, 216–218
Save As Template option, 27, 563
Filters
channel strips, 324–325
ES2 interface, 82–83
EXS24 interface, 130–131
processing EXS24 sound, 136–139
processing using Ultrabeat filters
and distortion circuit, 179–181
sculpting sound with, 92–98
Sculpture interface, 150
Ultrabeat interface, 166
Final Cut Pro, 574–575
Fine tuning, correcting pitch
discrepancies, 123
Flam, drum sounds, 296
Flatten tool, 255
Flex editing, 261–263
Flex markers
aligning to transients, 52
creating, 39–46, 56–57
quantizing audio, 49–53
shifting and stretching audio, 48–49
undoing, 43
Flex modes
Monophonic option, 54
Polyphonic option, 53
Rhythmic option, 52
selecting, 50–51
Slicing option, 262–263
special effects, 58
Flex Pitch
choosing, 60
doubling parts, 58–61
formant correction, 61–62
overview of, 58
timing adjustments, 62–63
Flex Time
creating flex markers, 39–46
creating/using Groove templates
with, 55–58
doubling parts, 58–61
editing transient markers, 53–55
quantizing audio, 49–53
replacing drums, 271
sound design with, 64–66
working with, 37–38
Flex view
creating flex markers, 39–46
enabling, 37–38
turning on/off, 262, 265
FM. See Frequency modulation (FM)
Fonts
production notes, 330
text attributes, 525
text styles, 526–527
Formant Shift hotspot, Audio Track
Editor, 62
Formants (resonance) correction
controls for, 159
with Flex Pitch, 61–62
Formats
audio, 582
options for surround sound, 420
setting for surround sound, 422
Forward, basic transport commands,
400–401
Frame rate, matching frame rate of digital
video clip, 565–566
Frequency controls, in oscillators, 87–88
Frequency modulation (FM)
creating hi-hat effect, 173–175
FM knob on filters, 95–96
Ultrabeat features, 168
using, 88–89
Full-view function, viewing relationships
between sounds in pattern, 185–188
Functions
accessing via Key commands, 20–21
customizing control bar, 8–10
full-view function, 185–188
Functions > Name Regions by
Track Name, 314
MIDI Transform >
Custom Humanize, 312
MIDI Transform > Humanize,
303–305, 311
modifier keys for working with,
24–25
Scene Cuts function, 571–572
G
Gain
Gain Reduction meter, 434
Multichannel Gain plug-in,
441–442
Gate Time parameter, for altering
articulation, 289–290
Global edits
arrangements, 218
extending arrangements, 227–231
inserting material into
arrangement, 218–221
inserting space into arrangement,
221–223
removing material from
arrangement, 223–227
Global tracks
displaying, 68
positioning and editing markers,
206–207
showing/hiding, 425
Go To Position command
navigating projects, 207–208
notation and, 539
Grain Size parameter, 66
Graphs/girds, entering notes graphically,
503–508
Groove tracks, creating/using, 55–58
Group Clutch
activating/deactivating Mixer
groups, 259–261
assigning channel controls and,
403
assigning channels to Mixer
groups and, 344–346
repairing drums with marquee
transient and, 265
Group inspector
accessing group settings, 256–257
phase-locked option, 261, 263
Group Settings window, automation
mode, 391–392
Groups
applying automation to multiple
tracks simultaneously, 390–393
assigning vocal track to VCA
group, 393–396
deactivating, 403
mixer groups. See Mixer groups
organizing zones into groups,
139–142
routing individual sounds for
processing, 143
view options, 122
Gtr Ostinato track, quantizing, 52–53
Guides, View menu, 535
Guitar notation
- creating chord charts, 528–531
- creating chord grids, 532–536
- creating polyphonic staff style, 515–517
- overview of, 515–517
- preparing MIDI regions, 536–538
- text styles, 524–525
- text use in, 524–525
- transcribing performances, 536
- viewing MIDI data, 538–541

Guitars
- creating comps, 250–255
- creating new parts from existing, 245–246
- fixing clicks, 242–245
- importing channel strips and data, 320–322
- packing parts into take folder, 246–250
- printing parts, 553–556
- processing sound, 159
- removing material from arrangement, 223–227
- smoothing transitions with crossfades, 236–239
- switching contents of plug-in window, 334–336

Half-time, manipulating timing of audio regions, 35–36

Hardware
- incorporating external effects processor, 369–370

Harmony/harmonics
- EXS24 filter settings, 137
- hi-hat effect and, 173
- ring modulation and, 90
- sidebands and, 89
- using Flex Time and Pitch to double a part, 60–61

Headphones
- creating headphone mix using pre-fader sends, 361–364

High-pass filters
- on LFE channel, 440
- multimode filters, 96–97, 136 in Ultrabeat, 172, 179–180

Hi-hats
- creating hi-hat sounds, 173–175
- panning stereo tracks, 331
- separating MIDI events (kicks from hi-hats), 313–314
- trimming HiHat region of drum track, 259–260

Humanize function
- customizing, 312
- transform functions, 303–305, 307, 311

I
Importing
- Broadcast WAVE files, 575–577
- channel strips and data, 320–322

Key commands
- for, 29
- Logic projects, 321
- media, 574
- project settings, 30, 312
- screensets, 30
- XML, 574–575

Inner Loss, damping string material, 151

Inputs
- choosing stereo inputs, 6
- labeling, 364–367
- processing audio input, 175

Insert effects, multi-mono effects, 436–440

Inspectors
- accessing channel strips, 11
- Event inspector, 511, 515
- Group inspector, 256–257, 261, 263
- Region inspector, 515, 538–539, 540
- viewing/hiding, 13

Instrument Editor
- See EXS24 Instrument Editor

Intensity parameter, modulation router, 99, 105

Intensity range, creating with envelope generator, 132

Interfaces
- assigning outputs for surround sound, 420–422
- built-in amplifiers, 364
- comparing ES2 and EXS24, 130
- creating headphone mix using pre-fader sends, 361–364
- customizing for improved workflow, 8–10
- ES2 user interface, 82–83
- EXS24 user interface, 120–121
- labeling inputs/outputs, 364–367
- output channels in, 327
- Sculpture user interface, 150–151
- Ultrabeat, 166

I/O (input/output). See Inputs; Outputs

J
Jitter generators, in modulation section of Sculpture, 159

Join > Regions option, Edit menu, 314, 541

Junction tool, changing transitions between markers, 211

K
Key commands
- assigning for MIDI controllers, 399–401
- assigning generally, 17–20
- backing up, 29
- functions accessible via, 20–21
- list of common, 24–25
- for viewing assignments, 16–17

Key focus, assigning, 14

Key Range parameters, for sampler instrument, 123

Key signatures
- displaying global tracks, 69
- entering notes graphically and, 505

Keyboards
- Chord Memorizer window and, 471
- MIDI. See MIDI keyboards
- onscreen musical keyboard, 168
- Step Input keyboard, 513–515

Kicks
- adjusting project feel, 288–289
- creating kick drum sounds, 168–171
- modifying region velocity, 285–287
- production note example, 330
- quantizing drums, 264–265
- replacing drums, 269–276
- separating MIDI events (kicks from hi-hats), 313–314
- side chain effects, 350–355

Knobs
- assigning channel controls, 401–405
- mapping controls to multiple parameters, 405–407

Latch mode, for automating recordings, 395

Layer menu
- Click & Ports layer, 460
- Create Layer, 462
- Rename Layer, 463

Layouts
- Show Score sets, 549
- Show Staff Styles, 518–519

Learn by Key Label button, assigning key commands, 18–19

Learn mode
- assigning channel controls, 401–405
- changing fader banks, 412–415
creating button for switching between modes, 411
mapping controls to multiple parameters, 406–407
Learn New Assignments button, 400–401
Legato effect, with Gate Time parameter, 290
Level meters, MultiMeter plug-in, 443
Level sliders, Down Mixer plug-in, 445–446
LFE. See Low-frequency effects (LFE)
LFOs. See Low-frequency oscillators (LFOs)
Library
Chord Grid Library, 532
selecting kick sound from, 273–274
List Editors button, 570
Lists area, Marker Lists, 214–216
Load Sample command, 176
Locators
inserting space into arrangement, 221–223
left and right locators in global edits, 219
setting, 291
Zoom to Fit Locators command, 387
Locking screensets, 15, 19
Loop Browser, displaying Apple Loops, 493–494
Loops
converting into aliases, 280–281
creating loop points for samplers, 125–129
Region parameter, 36, 488
using Apple Loops with touch tracks, 493–497
Low-frequency effects (LFE)
arbitrary processing, 439
multi-mode filters, 96–97, 136–137
in Ultrabeat, 172, 179
LVOX channel
extended plug-in parameters, 338–339
placing effects, 337–338
M
Mallet-Bell track, 290–296
Mapped instruments, creating, 542–547
Marimba track
MIDI signals in Environment, 460–462
using monitor objects, 463–465
Marker Lists, 214–216, 571
Marker tracks
Create Marker button on track header, 207–208
deselecting regions, 210, 227
displaying, 220, 425
inputting markers directly into, 209
positioning and editing markers, 206–207
Markers
creating, 206–210
creating flex markers, 39–46
editing positions of, 210–212
displaying, 220, 425
navigating using, 214
overview of, 206
scene markers, 571–572
shifting and stretching audio, 48–49
for spotting (identifying) where to add music to video, 569–571
viewing transient, 263
Marquee tool
dividing regions at selection borders, 254
modifier keys for working with, 25
playing arrangements, 201–202
playing selected area of project, 202–203, 266
repairing drums, 265–269
selecting using Tool click zones, 25–26
shifting and stretching audio, 46–49
Master channels
creating master multichannel file of surround mix, 446–448
downmixing, 444–446
toggling between Tracks view and All view, 328
working with surround sound, 424
Material Pad
constructing string quality, 151–152
processing sound, 158
Media
importing Broadcast WAVE files, 575–577
importing generally, 574
importing XML, 574–575
Media Loss, controlling damping of string, 152
Metronome
auditioning tempo, 580
checking beat mapping, 76
turning on/off, 53, 57
Middle C preferences, MIDI keyboard, 81
Middle-side (MS) mode, working with stereo tracks, 334
MIDI controllers. See also Control surfaces
assigning channel controls, 401–405
assigning generally, 399
assigning transport controls, 399–401
auditioning crash symbol sample, 177
auditioning drum pattern created with step sequencer, 182–183
auditioning drum sequences, 184
auditioning fast tremolo effect, 179
auditioning filter and distortion effects, 180–181
auditioning hi-hat effect, 173
auditioning kick drum sounds, 169–171
auditioning snare drum sounds, 172–173
auditioning Ultrabeat sounds, 166–168
buttons for switching between modes, 410–412
changing fader banks, 412–415
controlling live automation, 380
creating zones and adding modes for, 407–410
entering notes into score, 514–515
mapping controls to multiple parameters, 405–407
navigating Environment window and, 460–462
overview of, 398
triggering key command remotely, 22
MIDI editing. See Advanced MIDI editing
MIDI events. See Events
MIDI keyboards
envelope generators, 103–106
exploring Oscillator 1 waveforms, 83–84, 86–88
exploring Oscillator 2 waveforms, 84–88
exploring Oscillator 3 waveforms, 85–88
Frequency Modulation (FM), 88–89
listening to looping selection, 129
listening to results of EXS24 filter settings, 137
low-frequency oscillators, 100–102
Middle C preferences, 81
playing slices, 135–136
sculpting sound with filters, 92–98
working with modulation, 98–100
MIDI plug-ins, 452–458
MIDI real time processing
creating Environment objects, 462–463
creating signal chains, 475–476
in Logic Environment, 458
navigating Logic Environment, 458–462
overview of, 451
review, 498–499
using Apple Loops with touch tracks, 493–497
using arpeggiator objects, 465–469
using cable switcher objects, 483–488
using chord memorizer objects, 470–472
using delay line objects, 472–475
using MIDI plug-ins, 452–458
using monitor objects, 463–465
using touch track objects, 489–493
using transformer objects, 476–483
MIDI regions. See also Audio regions;
Regions
affecting display of MIDI regions, 515
beat mapping, 69–73
checking beat mapping, 73–74
creating one-measure region in Tracks area, 487–488
creating sampler instruments, 120
manipulating timing, 36
marquee selection techniques with, 269
parameters affecting display of, 515
preparing for notation, 536–538
MIDI Thru
adding arpeggiator to Tracks area, 466
applying Region parameters to incoming MIDI signals, 285
assigning selected tracks to Environment objects, 545–546
assigning Touch Tracks object to selected track, 492
changing track objects, 475–476
MIDI transforms. See Transforms
Mix, controlling
applying automation to multiple tracks, 390–393
assigning buttons for switching between modes, 410–412
assigning channel controls, 401–405
assigning transport controls, 399–401
assigning vocal track to VCA group, 393–396
bending automation curves, 389–390
changing fader banks, 412–415
control surfaces, 398
copying automation data, 384–388
creating zones and adding modes, 407–410
editing automation data, 380–381
mapping controls to multiple parameters, 405–407
overview of, 379
review, 415
snapping automation data to timeline, 381–384
trimming automation values, 396–398
Mix, managing
All view, 326–328
assigning channels to Mixer groups, 339–344
changing plug-in locations, 337–338
channel strip filters, 324–325
creating production notes, 329–331
disabling Mixer groups, 344–346
importing channel strips and data, 320–322
Mix group display modes, 322
Mix groups, 339
Mix Tracks view, 323–324
overview of, 319
panning stereo tracks, 331–334
plug-in extended parameters, 338–339
review, 346–347
signal flow in. See Signal flow
Single view, 328
switching contents of plug-in window, 334–336
Mix, surround sound
adjusting center and LFE levels, 427–429
balancing stereo to surround signals, 429–432
bouncing, 446–448
checking, 441–444
downmixing, 444–446
overview of, 423–425
Surround Panner for positioning signals in surround field, 425–427
Mixer groups
activating/deactivating, 259–261
assigning channels to, 339–344
configuring, 256–259
disabling temporarily, 344–346
editing groups with Flex editing, 261–263
editing using, 255–256
overview of, 339
quantizing drums with phase-locked editing, 263–265
Mixers
adjusting center and LFE levels, 427–429
All view, 326–328
applying automation to multiple tracks, 391–393
assigning vocal track to VCA group, 393–396
changing plug-in locations, 337–338
channel strip filter buttons, 324–325
dedicating separate screen set to, 11–12
display modes, 322
maximizing screen space, 13–14
panning stereo tracks, 331–334
parallel compression using post-pan sends, 356–361
routing audio signals, 349
Single view, 328
Tracks view, 323–324
in Ultrabeat interface, 167
working with surround sound, 423–425
Modes. See also by individual types
buttons for switching between, 410–412
creating, 407–410
Modulation
envelope generators as source of, 104
Index

in ES2, 82–83, 113
in EXS24, 130–131
Frequency Modulation (FM), 88–89
of intensity range by note velocity, 132
processing EXS24 sound, 136–139
ring modulation, 90–91
routing in Ultrabeat, 170–171
in Sculpture, 150, 159–162
of snare drum sound, 172–173
Tension Mod slider, 152
in Ultrabeat, 166, 168
working with, 98–100
Modulation router, 98–100
Modulator oscillator
in frequency modulation, 88–89
in ring modulation, 90–91
Modulator plug-in, 452–458
Monitor objects
cabling delay line object to, 473
cabling memorizer object to, 470
changing track objects, 475–476
dragging cable switcher output to, 484
using, 463–465
using with Transformer object, 480
Monophonic
changing channel modes, 351
downmixing surrounding sound to, 444–446
low-frequency oscillators and, 102
selecting flex modes, 50, 54
Ultrabeat channel capacity, 191
Morph Pad, modulation in Sculpture, 159–161
Mouse
creating/adjusting flex markers, 46
positioning mouse pointer, 47–48
Tool menu control with two-button mouse, 26–27
Movie pop-up menu, 564
Movies. See Picture
MS (middle-side) mode, working with stereo tracks, 334
Multichannel Gain plug-in, 441–442, 444
Multichannel surround processor, 433–436
MultiMeter plug-in, 442–443
Multimode filters
in EXS24, 136
processing sound, 158
types of, 96–97
in Ultrabeat, 172, 179
Multi-mono surround processor
insert effects, 436–440
types of surround processors, 433
Musical Typing
MIDI signals in Environment, 461
playing Ultrabeat sounds, 168
Muting/unmuting (Mute tool)
automating, 380–381
drum regions, 260–261
guitar track, 247
mVox Note region, 118
piano regions, 75

N
Naming
audio regions, 249
markers, 212–214
monitor objects, 465
regions by track name, 314
Navigation
of arrangements, 198
Go To Position command, 207–208
of picture, 568
Set Rounded Locators by Selection command, 225
using markers, 214
New Assignment button, 399–400
New Track with Duplicate Settings button, 59
New Tracks dialog, 5–7, 560
Next Marker command, 214
No Overlap option, Drag menu, 268
Noise Gate, signal threshold settings, 352–355
Noise generators
creating snare drum sounds in Ultrabeat, 171–173
in Oscillator 3, 85
Notating sequencer, Logic as, 501
Notation
adjusting note length, 510–512
consolidating drum tracks, 541–542
creating, 502–503
creating chord charts, 528–531
creating chord grids, 532–536
creating mapped instruments, 542–547
creating parts for printing, 552–556
creating polyphonic staff style, 517–524
creating score sets, 548–551
dragging notes into score, 509–510
drum notation, 541
entering notes graphically, 503–508
entering notes using step input, 513–515
overview of, 501
preparing MIDI regions for, 536–538
review, 557
text styles, 525–527
text use in, 524–525
transcribing performances, 536
viewing MIDI data accurately, 538–541
Note Attributes dialog, 540–541
Note On Random modulators, Sculpture modulation, 159
Note Repeater MIDI plug-in, 472
Notes. See also Notation
adjusting length of, 510–512
altering articulation of MIDI notes, 289–290
dragging into score, 509–510
entering graphically, 503–508
entering using step input, 513–515
selecting events by note pitch, 314
selecting lowest note, 300
Notes (production notes), 329–331

O
Object group, entering notes graphically, 504
Object parameters
overview of, 467–468
Range parameter, 484–485
Repeats parameter, 473–474
setting, 481
Objects
creating Environment objects, 462–463
resizing Environment objects, 487
Sculpture, 153–157
using arpeggiator objects, 465–469
using cable switcher objects, 483–488
using chord memorizer objects, 470–472
using delay line objects, 472–475
using monitor objects, 463–465
using touch track objects, 489–493
using transformer objects, 476–483
Octaves
changing, 282–283
selecting lowest note and, 300
transposing regions, 283–285
Offsets, randomizing for triggers, 190–191
Onscreen musical keyboard, 168
Operation on Byte 2, Transform window, 304
Operations on Selected Events,
Transform window, 304, 309
Option key, modifier keys for working with functions, 24–25
Option-drag
- copying automation data, 384–388
- positioning flex markers, 45

Options menu, 394

Option-Shift key, modifier keys for working with functions, 24–25

Organ track
- looping, 36
- manipulating timing of, 34–35

Oscillators
- creating kick drum sounds in Ultrabeat, 169
- exploring Oscillator 1 waveforms, 83–84, 86–88
- exploring Oscillator 2 waveforms, 84–88
- exploring Oscillator 3 waveforms, 85–88
- Frequency Modulation (FM), 88–89
- low-frequency oscillators, 100–102
- offsetting pitch range in snare, 188–191
- ring modulation, 90–91
- sending signal to filter in Ultrabeat, 179
- synchronization, 91–92

Outputs
- All view for displaying output channels, 326–328
- assigning for surround sound, 420–422
- choosing stereo output, 6
- ES2 synthesizer interface, 82–83, 113–114
- EXS24 interface, 130–131
- labeling, 364–367
- routing individual sounds for processing, 143–147
- Sculpture interface, 150
- Ultrabeat interface, 166, 191
- viewing channel assignments, 422

P

Pan controls
- assigning buttons for switching between modes, 410–412
- creating Pan mode, 409
- creating parallel compression using post-pan sends, 356–361
- mapping controls to multiple parameters, 405–407
- panning stereo tracks, 331–334
- positioning send controls, 356
- working with surround sound, 424

Parallel compression, using post-pan sends, 356–361
Parallel processing, filters and, 98

Parameters
- affecting display of MIDI regions, 515
- applying to multiple zones, 139–142
- automating, 188–191
- copying automation data between, 388
- Delay parameter, 288–289
- EXS24, 130–132
- EXS24 Instrument Editor, 122–123
- extended plug-in parameters, 338–339
- Gate Time parameter, 289–290
- Object parameter, 467–468
- Region parameter, 283
- Repeats parameter, 473–474
- Template parameter, 298–300
- viewing, 125

Pattern mode, enabling, 182

Patterns
- copying, 183
- editing, 188
- full-view of relationships between sounds in, 185–188
- sequencing sounds, 183–185
- swing pattern applied, 185

Pencil tool
- drawing out clicks in audio file, 244–245
- inputting markers directly into Marker track, 209
- positioning notes in staff, 506
- Period (.), positioning playhead, 207
- Phase Invert button, Multichannel Gain plug-in, 444
- Phase-locked
  - Group inspector option, 261
  - quantizing drums, 263–265
- Phrasing, manipulating with Flex Time, 37
- Physical modeling
  - in Sculpture, 149
  - in Ultrabeat, 168
- Piano Roll Editor
  - adjusting note length, 510–512
  - adjusting Q-Velocity and Q-Length parameters, 290–300
- changing note octave, 282–283
- checking Beat Mapping, 73–74
- Collapse Mode button, 313
- correcting doubled kicks, 276
- creating note in one-measure MIDI region, 487–488
- creating polyphonic staff style, 518
- Humanize function, 507
- viewing notes entered graphically, 125
- viewing notes in chords, 297
- viewing track contents, 291

Piano tracks
- balancing stereo to surround signals, 429–432
- beat mapping, 72–73
- breaking chords apart, 296
- creating new transform functions, 305–311
- creating post-production audio, 560–563
- panning stereo tracks, 331–333
- rendering software instrument tracks as audio, 374–376
- sound design with Flex Time, 64–66
- staff style options, 517
- working with MIDI transform sets, 303–305

Pick exciter object, 154–157

Pickups
- adjusting, 157
- constructing string quality, 154–157

Picture
- adding scene cuts, 571–573
- creating score, 579–582
- exporting audio to, 582–584
- markers for spotting (identifying) where to add music, 569–571
- navigating, 568
- opening movies, 563–566
- overview of, 559
- positioning events on timeline, 577–579
- review, 582–584
- synchronizing video and audio, 566–568

Pitch
- adjusting playback speed, 58
- adjusting timing, 62–63
changing by dragging pitch slider, 177
correcting formant, 61–62
doubling parts, 58–61
Flex Pitch, 58
offsetting pitch range in snare, 188–191
oscillator pitch and waveform selection, 101–102
overview of, 33
review, 74–76
of samples, 123
selection criteria, 309
separating MIDI events by, 314
Play, basic transport commands, 400–401
Play from Left Window Edge command, 203–204
Playback adjusting speed of, 58
of arrangement with Bar ruler, 198–199
of arrangement with Marquee tool, 201–203
controlling movies, 568–569
delaying, 288
omitting sections of arrangements, 200–201
searching for playback functions, 20
specialized commands for, 203–205
stopping with spacebar, 200
Ultrabeat, 168, 183
Playhead cycle areas and, 200
locating in Score Editor, 513
moving Bar ruler to, 199
navigating using markers, 214
options for positioning, 207
placing events by playhead position, 579
positioning with Marquee tool, 201–203
Plug-ins
Arpeggiator MIDI plug-in, 465
Bypass Effects Plug-ins, 373, 376
Chord Trigger MIDI plug-in, 470
Compressor plug-in, 355
Direction Mixer plug-in, 331–334
Down Mixer plug-in, 444–446
extended parameters, 338–339
importing, 321
I/O plug-in, 367–370
MIDI plug-ins, 452–458
Multichannel Gain plug-in, 441–442
MultiMeter plug-in, 442–444
Note Repeater MIDI plug-in, 472
processing EXS24 sound, 143
Space Designer plug-in, 433–436
switching contents of plug-in window, 334–336
Test Oscillator plug-in, 351–354
Tuner plug-in, 124
Ultrabeat. See Ultrabeat instrument plug-in
using plug-in extended parameters, 337–338
Preset File parameters, 162
transform functions, 305–306
Previous Marker command, 214
Printing parts, 552–556
Processors
creating signal chains, 475–476
incorporating external effects processor, 367–370
side chaining, 350
surround sound, 433
Production notes, 329–331
Project Setting window
Audio settings, 422, 565
Global option, 553–554
Projects
creating templates, 4–5
importing settings, 30, 312
opening/creating automatically, 27–29
saving templates, 27
Q-Flam parameter, Region parameters, 296–298
Q-Length parameter, Region parameters, 298
Q-Range parameter, Region parameters, 294–296
Q-Strength parameter, Region parameters, 293–296
Q-Swing parameter, Region parameters, 293
Quantization adjusting Q-Velocity and Q-Length parameters, 298–300
arpeggiating chords with Q-Flam, 297
of audio, 49–53
correcting and modifying rhythm, 290–296
of drums with phase-locked editing, 263–265
Groove templates as, 55, 57
notation and, 539
selecting options from Quantize menu, 51–52
Quick Swipe Comping, 250–255
QuickTime. See Apple QuickTime
Q-Velocity parameter, Region parameters, 298
Random option, Velocity pop-up menu, 310, 468–469
Randomize function, ES2 synthesizer, 114
Randomize selection, Offset shortcut menu, 191
Range parameter, Object parameters, 484–485
Read option, automation mode, 395, 398
Realtime processing. See MIDI real time processing
Reassign Track menu, 471–472
Record, basic transport commands, 400–401
Region inspector
Interpretation option, 540
parameters affecting display of MIDI regions, 515, 538–539
Region parameters adjusting project feel, 288–289
altering MIDI events, 283
applying permanently, 287
correcting and modifying rhythm, 290–296
Gate Time parameter, 289–290
Loop options, 36, 488
modifying region velocity, 285–287
Q-Flam parameter, 296–298
transposing regions, 283–285
Regions. See also Audio regions; MIDI regions aliases, 280–283
applying crossfades to multiple, 240–242
Bounce Regions In Place, 372
creating multiple zones from region transients, 132–136
defining transient markers for, 267
deselecting, 227, 265
joining (combining), 314
modifying velocity, 285–287
moving into Marker track, 209–210
moving playhead position, 205
naming by track name, 314
playing Vox Telephone region, 221
rhymic feel between, 55–58	
tool click zones for editing, 25–26
transposing, 283–285
trimming HiHat region, 259–260
trimming Region End to Next Region, 230
viewing content of, 54
Relative mode, compared with Trim mode, 398
Release slider, envelope generators, 132
Repeat Multiple option, Edit menu, 282
Repeats parameter, Object parameters, 473–474
Replace or Double Drum Track, Track menu, 270–275
Resolution
of arpeggiated notes, 469
constructing string quality, 152
setting Object parameters, 482
Resonance controls for formants correction, 159
correcting formants with Flex Pitch, 61–62
EXS24 filter settings, 137
processing using Ultrabeat filters and distortion circuit, 180
sculpting sound with filters, 94–95
Reverb, multichannel effects, 433
Rewind, basic transport commands, 400–401
Rhythm. See also Rubato (rhythmic flexibility)
correcting and modifying, 290–296
creating rhythmic echoes, 145–146
entering notes graphically and, 506
flex mode options, 52
manipulating with Flex Time, 37
moving rhythmic feel between regions, 55–58
swing pattern, 185
tightening uneven, 53–54
Right mouse button, 26–27
Ring modulation
applying in creating hi-hat effect, 173–175
overview of, 90–91
Ultrabeat features, 168
Rubato (rhythmic flexibility)
beat mapping audio regions, 74–76
beat mapping MIDI regions, 69–73
checking beat mapping in Piano Roll Editor, 73–74
creating tempo changes using Beat Mapping track, 67–69
Ruler. See Bar ruler
Samples (audio)
loading, 176–179
mapping across pitch ranges, 117
mapping in zones, 119
matching sample rate of video audio track, 564–566
memory stores and, 125
pitch of, 123
Samples (time measurement), displaying timeline as, 127
Saturation control, testing kick drum sounds in Ultrabeat, 169
Save As option, File menu, 216–218
Save As Template option, File menu, 27, 563
Saxophone tracks balancing stereo to surround signals, 430–432
multichannel effects, 433–436
Surround Panner for positioning signals in surround field, 425–427
Scene cuts, 571–573
Scene markers, 571–572
Scissors tool
changing tool assignments by screenset, 23
selecting, 223
trimming HiHat region of drum track, 259–260
Score
creating picture score, 579–582
creating score sets, 548–551
dragging notes into, 509–510
Score Editor
adjusting note length, 510–512
consolidating drum tracks, 541–542
creating chord charts, 528–531
creating chord grids, 532–536
creating mapped instruments, 542–547
creating notation, 502–503
creating parts for printing, 552–556
creating polyphonic staff style, 517–524
creating score sets, 548–551
dragging notes into score, 509–510
drum notation, 541
entering notes directly into, 501
entering notes graphically, 503–508
entering notes using step input, 513–515
guitar notation, 515–517
options for displaying, 503
overview of, 501
preparing MIDI regions for notation, 536–538
review, 557
text styles, 525–527
text use in notation, 524–525
transcribing performances, 536
types of MIDI editors, 283
viewing MIDI data accurately, 538–541
Score sets
creating, 548–551
Ensemble option, 556
printing parts, 552–556
Screen space. See Workspace
Screensets
adding tool assignments to, 22–23
creating, 10–12
importing, 30
locking, 15
making Environment window part of, 458–459
maximizing screen space, 13–14
Scrubbing regions, around clicks or pops, 243–245
Sculpture
adjusting pickups, 157
modulation, 159–162
objects, 153–157
processing the sound, 158–159
review, 163
saving and trying presets, 162
sound design with, 149
string element, 151–152
Ultrabeat compared with, 175
user interface, 150–151
Selection. See also Marquee tool; Pointer tool
All Following of Same Track, 311
combining selection commands with global edits, 225
inverting, 300–301
lowest note, 300
MIDI events, 300–302
Select All, 61, 366
Select Events by Conditions, 304, 308
Send controls
creating headphone mix using pre-fader sends, 361–364
creating parallel compression using post-pan sends, 356–361
effects, 433–436
mapping to multiple parameters, 405
positioning, 356
routings with, 349
Send Event, 15
Sequences, step sequencer in creating drum patterns, 181–183
Set Locators and Play
playback using specialized commands, 205
utilizing functions accessible via key commands, 21
Set Rounded Locators by Selection command, Navigate menu, 225
Settings menu, Compressor Tools, 359
Setup
backing up/transporting, 29
speeding up workflow. See Workflow, speeding up
Shift key, modifier keys for working with functions, 24
Show Mixer, View menu, 256
Side chaining
effects, 350–355
processing audio input with Ultrabeat, 175
techniques, 355
Sidebands
harmonics, 89
ring modulation and, 90
Signal chains, 475–476
Signal flow
bouncing in place, 371–374
creating headphone mix using pre-fader sends, 361–364
creating parallel compression using post-pan sends, 356–361
incorporating external effects processor, 367–370
 labeling audio interface inputs/outputs, 364–367
MIDI signals in Environment, 461–462
overview of, 349
positioning send controls, 356
review, 376–377
side chain effects, 350–355
Ultrabeat buttons, 179
Signatures. See also Key signatures
signature tracks, 69
time signatures for inserting space into arrangement, 222–223
Sine wave, generating raw waveforms, 351–354
Single view, Mixers, 322, 328
Skip cycle, Mixers, 200–201
Slices/slicing
creating multiple zones from region transients, 134–135
flex modes, 50–51, 262–263
Slice at Transient Markers, 64
Slope, as decibels per octave, 94
Slope control, testing kick drum sounds in Ultrabeat, 169
Smoothing control, Modulator plug-in, 458
SMPTE timecodes
adding display to Tracks area, 561–563
creating picture score, 580–581
in Marker List, 571
navigating projects, 207–208
scene markers and, 572
synchronizing audio and video, 566–568, 577–579
Snap Automation, snapping automation data to timeline, 381–384
Snap Edits to Zero Crossings, Audio File Editor, 127
Snap menu options, Automation Snap Offset, 383
Snap to menu, working with arpeggiated notes, 469
Snap to parameter, Object parameters, 482
Snares
applying edits across multiple tracks, 262–263
creating rhythmic echoes, 145–146
creating snare drum sounds, 171–173
muting drum regions, 261
offsetting pitch range, 188–191
randomizing existing triggers, 186–187
repairing drums with marquee transient, 265–269
sequencing sounds, 184–185
Software instruments. See also by individual types
creating post-production audio, 560–563
creating/configuring tracks, 7
delay in engaging live mode, 84
rendering as audio, 374–376
Soloing (Solo tool)
amatically selecting, 25–26
drum track, 240
enabling/disabling Transport bar, 146–147
modifier keys for working with, 25
snare track, 184–185
Strings and Tremolo tracks, 282–283
trumpet track, 39
Sound design
with Flex Time, 64–66
with Sculpture. See Sculpture
Sound generation
ES2 synthesizer, 82–83
Sculpture, 150
Ultrabeat, 166, 168
Sound triggers. See Triggers
Source parameter, modulation router, 99, 105
Space Designer plug-in, 433–436
Spacebar, stopping playback with, 200
Speakers
assigning outputs for surround sound, 420–422
isolating output of, 441–442
positioning signals in surround field, 425–427
Speed, flex modes, 58
Spotting, identifying where to add music to video, 569–571
Spread sliders
balancing stereo to surround signals, 430
working with stereo tracks, 333
Staccato effect, with Gate Time parameter, 289–290
Staff style
creating polyphonic staff style, 517–524
options, 517
Show Staff Styles, 518–519
Startup Action pop-up, 27–29
Status menu, specifying MIDI event type, 308
Stems, creating for dubbing, 584
Step Editor, types of MIDI editors, 283
Step grid, sequencing sounds, 183–185
Step Input keyboard, entering notes into score, 513–515
Step mode, for automating parameters, 188–191
Step sequencer
creating drum patterns, 181–183
sequencing sounds, 183–185
Ultrabeat interface, 166–167
Stereo
balancing to surround signals, 429–432
changing channel modes, 351
creating rhythmic echoes, 145–146
downmixing surround sound to, 444–446
Mixer channels, 331–334
panning stereo tracks, 331–334
Ultrabeat channel capacity, 191
Stiffness (rigidity), of string material, 151
Stomp boxes, 370
Stop, basic transport commands, 400–401
Strength parameter, string parameters, 154–155
Stretching time, 34–36
String
as basic element in Sculpture, 151–152
Ultrabeat exciter types, 175
Strings and Tremolo Pad tracks
aliases example, 280–283
transposing regions, 283–285
Style menu
Guitar option, 517
Staff style options, 516–517
As Text option, 485
Subwoofers
low-frequency effects, 420
multi-mono insert effects, 436–440
Summing Stack, creating, 360–361
Surround Panner
adjusting center and LFE levels, 427–429
balancing stereo to surround signals, 429–432
positioning signals in surround field, 425–427
Surround sound
adjusting center and LFE levels, 427–429
assigning audio interface outputs, 420–422
balancing stereo to surround signals, 429–432
bouncing surround mix, 446–448
checking surround mix, 441–444
configuring, 420
downmixing, 444–446
effects, 433
formats, 422
mixing in, 423–425
multichannel effects, 433–436
multi-mono insert effects, 436–440
overview of, 419
positioning signals, 425–427
review, 448
Swing pattern, 185
Swing settings, Region parameters, 293
Symmetry
Modulator plug-in Symmetry control, 457
Ultrabeat Asymmetry control, 169
Synchronization
of audio events to SMPTE positions, 577–579
of oscillators, 91–92
of video and audio using SMPTE timecode, 566–568
Synth Pulse track
selecting MIDI events, 300–302
using template parameters, 298–300
Synthesis, Sculpture approach to, 149
Synthesizers. See also by individual types
altering articulation of, 289–290
hybrid, 81
tuning oscillator relationships, 453–458
T
Takes
creating transition between, 252
packing parts into take folder, 246–250
tools in take folder, 255
Tape Delay parameter, 338–339
Target parameter, modulation router, 99, 105
Templates
adjusting Q-Velocity and Q-Length parameters, 298–300
backing up, 29
creating, 4–5
creating/using Groove templates with Flex Time, 55–58
saving project templates, 27
startup preferences, 27–29
Tempo. See also Time/timing
auditioning, 580
changing using Beat Mapping track, 67–69
delay settings, 288
managing, 73–75
new tempo events, 70–71
rubato (rhythmic flexibility), 67
stretching and compressing time, 34–36
Tempo pop-up menu
checking beat mapping in Piano Roll Editor, 73–74
Tempo Sets option, 73, 75
Tempophone mode
flex modes, 58
sound design with, 64–66
Tension Mod slider, 152
Test Oscillator plug-in, 351–354
Text/Text tool
changing region name, 59
renaming audio regions, 249
renaming monitor objects, 465
As Text option of Style menu, 485
text styles, 525–527
text use in notation, 524
Thresholds
kick settings, 272–273
signal threshold settings, 352–353
Ticks, compared with frames of video, 578
Timbre
consistency of, 286
formant correction with Flex Pitch, 61–62
hi-hat effect and, 173
oscillator synchronization and, 92
ring modulation and, 90
string parameters, 154–156
Time signatures, inserting space into arrangement and, 222–223

Time stretch
creating flex markers in Flex view, 40
Edit menu command, 36

Timecodes. See SMPTE timecodes

Timeline
Audio File Editor, 127
positioning events on, 577–579
snapping automation data to, 381–384

Time/timing
beat mapping audio regions, 74–76
beat mapping MIDI regions, 69–73
checking beat mapping, 73–74
creating flex markers, 39–46
creating tempo changes, 67–69
creating/using Groove templates, 55–58
editing transient markers, 53–55
overview of, 33
quantizing audio, 49–53
review, 74–76
shifting and stretching audio, 46–49
sound design with Flex Time, 64–66
stretching and compressing, 34–36
working with Flex Time, 37–38

Tool click zones, for editing regions, 25–26

Tool menus
accessing, 23–24
controlling with two-button mouse, 26–27
location of, 22
saving to different screensets, 22–23

Toolbars, customizing interface, 9–10

Touch mode, automation mode options, 396–397

Touch tracks
using Apple Loops with, 493–497
using touch track objects, 489–493

Track menu
Convert Regions to New Sampler Track, 118–119
Replace or double Drum track, 270–275

Track stacks, creating, 360–361

Tracks. See also by individual types
applying automation to multiple, 390–393
applying edits across multiple, 261–263
creating new, 246
creating/configuring, 5–7
duplicating settings in, 59
viewing, 11–12

Tracks area
adding arpeggiator, 466
creating one-measure MIDI region, 487–488
editing marker positions, 210–212
enabling Flex view, 37–38
maximizing screen space, 13–14
positioning playhead, 201–203
removing material from arrangement, 223
transform functions, 311
viewing tracks, 11–12

Tracks view
filter buttons, 324–325
Mixers, 322–324

Tracks window, creating offline automation, 380

Transform window, types of MIDI editors, 283

Transformer objects
cabling to arpeggiator object, 480
configuring from Transformer window, 477–479
creating, 476
overview of, 476
positioning in Environment window, 479

Transforms
applying new transform sets, 311–312
creating new transform functions, 305–311
working with MIDI transform sets, 302–305

Transient Editing Mode, in Audio File Editor, 54

Transients
audio transients, 74–76
creating flex markers, 39–46
creating zones from, 133
creating/using Groove templates with Flex Time, 57–58
defining for regions, 267
delay line object and, 475
delaying pitch, 61–62
regions, 283–285

Tremolo
creating fast tremolo, 177–179
ring modulation as fast tremolo, 90
soloing, 282–283

Trigger Note Range menu, 119

Triggers
graphical view of, 186
randomizing existing, 186–187
randomizing offsets for, 190–191

Trim command
applying to automation values, 396–398
Edit menu options, 302
Region End to Next Region, 230

Trumpet tracks
adjusting center and LFE levels, 428–429
balancing stereo to surround signals, 430–432
soloing/unsoloing, 39, 46
working with Flex Time, 37–38
working with surround sound, 423–425

Tuner plug-in, 124

Tuning controls
correcting pitch discrepancies, 123
in oscillators, 87–88

U

Ultrabeat instrument plug-in
automating parameters in Step mode, 188–191
creating hi-hat sounds, 173–175
creating kick drum sounds, 168–171
creating snare drum sounds, 171–173
Drum Machine Designer and, 192
exploring sound generators, 168
full-view function, 185–188
loading samples, 176–179
overview of, 165
processing audio input, 175
processing using filters and distortion circuit, 179–181
review, 192–193
selecting sounds, 166–168
sequencing sounds, 183–185
step sequencer in creating drum patterns, 181–183
swinging pattern applied, 185
Undo (Command-Z), 208
Unpack tool, in take folder, 255
USB flash drive, transporting setup via, 29
User interfaces. See Interfaces

V
Variable-pulse wave, in oscillators, 85–86
Variation slider, string parameters, 154–155
VCA fader
assigning vocal track to VCA group, 393–396
trimming automation values, 396–398
Vector envelope generator
controlling modulation parameters, 111–113
listening to mix, 109–110
looping between oscillator mixes, 111
opening and assigning targets in mix mode, 106–108
overview of, 106
turning off Solo Point in mix mode, 109
Velocity
modifying region velocity, 285–287
Random parameter, 310, 468–469
Repeats parameter, 474
sensitivity parameters, 154
setting Object parameters, 482
Via parameter, modulation router, 99
Vibrato
frequency modulation as fast vibrato, 88
low-frequency oscillators and, 100–102
Video. See Picture
View menu
assigning color to objects, 465–466
Channel Strip Components >
Notes, 331
Guides, 535

selecting parameters for sampler instruments, 125
Show Mixer, 256
Views, Mixer, 322
Vintage Clay, 149
Vintage Electric Piano, 149
Vocal tracks, assigning to VCA group, 393–396
Voice mode, toggling on/off from Step mode, 191
Voice Separation tool, 523
Volume/volume controls
adjusting EXS24 volume, 139
assigning buttons for switching between modes, 410–412
assigning fader controls, 401–405
consistency of, 286
creating crescendo effect, 389–390
creating Volume mode, 410
mapping controls to multiple parameters, 405–407
positioning send controls, 356
Vox Note audio region, 118
Vox Telephone region, 221

W
Waveforms
analog, 168
digital waveforms as modulation source, 89
drawing out clicks in audio file, 244–245
generating raw waveforms, 351–354
oscillator pitch and, 101–102
oscillators, 83–88
smoothing transitions with crossfades, 236
testing kick drum sounds in Ultrabeat, 169
Waveshaper, processing sound, 158
Workflow, speeding up
accessing Tool menu, 23–24
adding tool assignments to screensets, 22–23
assigning Key commands, 17–20
backing up/transporting setup, 29
creating screensets, 10–12
creating templates, 4–5
creating/configuring tracks, 5–7
customizing interface, 8–10
importing screensets, 30
list of common key commands, 24–25
locking screensets, 15
maximizing screen space, 13–14
opening/creating projects automatically, 27–29
overview of, 3
review, 31
saving project templates, 27
Tool click zones for region editing, 25–26
Tool menu control with two-button mouse, 26–27
utilizing functions accessible via key commands, 20–21
viewing key command assignments, 16–17
Workspace
maximizing screen space, 13–14
minimizing EXS24 Instrument Editor, 126

X
XFade parameter, 129. See also Crossfades
XML (Extensible Markup Language), 574–575
X-Y (Planar) pad, 111–113

Z
Zones
creating multiple zones from region transients, 132–136
EXS24 Instrument Editor view options, 122–123
mapping controls to multiple parameters, 407–410
organizing into groups, 139–142
routing individual sounds for processing, 143
Zooming/Zoom tool
editing marker positions, 211
navigating drums track, 49–50
navigating to playhead position or to region, 205
in Score Editor, 555
selecting tracks, 229
viewing region content, 54
Zoom to Fit Locators, 387